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Standard Legal Notices

Copyright

Presentation and workbook copyright© 2024 by Multi Business Solutions. All
rights reserved. Printed in the United States of America. No part of this book
may be used or reproduced in any form or by any means without prior written
permission of Multi Business Solutions. Material remains the property of

Multi Business Solutions.

Disclaimer

This training material is presented without warranty of any kind, either
express or implied respecting the contents of this book, including but not
limited to implied warranties for the book’s quality, performance,

merchantability, or fitness for any particular purpose.

Trademark Acknowledgments

All product names and services mentioned in this workbook are trademarks or
registered trademarks of their respective companies. Multi Business

Solutions is not affiliated with any of these companies.
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About Your Trainer

Certified QuickBooks ProAdvisor, Samantha Pierce

Samantha is a certified QuickBooks expert who can guide you through
the maze of efficiently running a business. Samantha received her
Associate of Arts degree from MSCTC and then went on to NDSU
where she graduated with her Bachelor's of Accounting degree. For
over 10 years, Sam has worked in accounting departments for
companies ranging in size from small to large. For the last two years,
Sam has taught a QuickBooks Online class and Fundamentals of
Accounting Principles class at NDSCS.

The Multi Business Solutions team will help you master QuickBooks and
ensure your financial information is accurate and timely; better yet they will
arm you with critical knowledge of how to use the data to improve company
performance.

Multi Business Solutions
218-770-2691
office@multi-business-solutions.com
www.multi-business-solutions.com
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QuickBooks® Online Foundations

Important Information About the Structure of this Training.

Today’s course is intended as the foundation for using QuickBooks® as a bookkeeping,
business management and cash flow building tool. The material provides a critical basis for

establishing bookkeeping best practices and ensuring accurate financial information.

Please ask questions throughout the presentation.

Your Instructor is also available for one-on-one consultations.

In addition to what you will learn today these manuals are for use as a

post-class reference guide.

(The Craig’s Landscaping test drive company resets itself when you log
out. Occasionally you may encounter a screen shot that looks different
than what is posted in the manual. Our materials are updated throughout
the year, however with technology advances,
prompting updates, you may encounter an update
that is not yet reflected in this manual.)

We are happy you are here today and look forward

to helping you master QuickBooks!
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QuickBooks® Online Foundations

The most important reason to advance our knowledge of QuickBooks® Online and
basic bookkeeping principles, whether you are a business owner or employee, is to

gain an understanding of how to use our data to improve business performance.

While we identify specific learning objectives at the beginning of each section,
4 Overall Objectives include:

1. Introduction to basic features in QuickBooks Online and how they apply to best

practice bookkeeping and accounting principles.

2. How to effectively and efficiently use QuickBooks Online to manage daily tasks
and develop an understanding of how the data is entered, processed and

reviewed.

3. How to customize QuickBooks Online to meet the specific needs of a business.

The Importance of QuickBooks® Online and Managing Cash Flow:

Business owners typically identify cash flow as their number one area of concern.
QuickBooks Accounting Software, when utilized correctly, allows users to run cash
flow projections and develop a cash flow management strategy to prevent shortfalls.
This training will help participants develop a strong knowledge base of how to use

QuickBooks reports to manage a business and build cash flow.

The foundation of business success is in the daily use of accurate, real-time

financial data. What we measure, we manage; what we manage, we improve.
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The Power of QuickBooks® Online

It is important to focus on the areas of our business that contribute most to
profitability. QuickBooks helps us quickly identify areas of focus if we know

where to look.

The 80/20 rule, the Pareto Principle, is a powerful concept that consistently rings
true.

In most cases, 20% of our customers generate 80% of our net profit. At the same
time, 20% of the goods or services we sell contribute 80% of our revenue, etc. You
get the idea.

The most important aspect of accurate financial data

is the action plan it creates.

By generating daily reports that uncover the best customers, jobs, services, or
products, you will soon see how you can refocus internal efforts on doing highly

valuable work.

Accurate real-time data with one click access to reports, is an enormous benefit of

using QuickBooks® Online the “right-way”.
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Online Foundations

SECTION 1
GETTING STARTED

Objectives

Features

Setup Your Company File
Navigation

Action Steps

10
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Section 1Goals

Upon completion of Section 1, each participant will be familiar with the

following objectives:
» Options for creating a new company file.
* How to setup a new company file.

* How to navigate using QuickBooks.
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Features

Chrome Browser

There are a few things you need to know going forward.

Mew tab ’ T

Mew window Ctrl+N

Cookies and Cache

Mew incognito window  Ctrl+Shift+N

If you receive an error message when trying oy o
rrivacy (3P awnloads Ctrl+

tO aCCGSS your Company flle: Bockmarks 3
Zoom - 100%  + b

1. Click the three dots in the upper right prnt. Cute

n ® Money out Cast...

section of the Chrome browser. : | - I s
ave page as.. Ctrl+5 ore tools

Click More tools. e’ 4 e ce Gy e
Clear browsing data..  Ctrl+Shift+Del Settings

Click Clear browsing data. Extensions Help >
Task manager Shift+Esc it
Developer tools Ctrl+Shift+|

Clear browsing data

Basic Advanced

Timerange  All time - ’

Browsing history
1,025 items

4. Select the Time range, Cookies and
other site data, and Cached images

and files.

Downlead history

5. Click Clear data. Nore

Cookies and other site data

O O

[<]

From 189 sites

Cached images and files
319 MB

<]

Passwords and other sign-in data
None

O

Autofill form data

O Cancel Clear data

Important! Chrome is the recommended browser used to access QuickBooks Online.

]
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Features

Bookmarks

You can bookmark the login window and your favorite pages. To bookmark the login page,

follow these steps:

6. Click the star on the top right of the
browser bar to create a bookmark.

7. Choose a name for your bookmark
and select a folder.

8. Click Done.

Incognito

Incognito mode provides more privacy

and does not track your browsing history.

To open an incognito window or tab,

follow these steps:

9. Select the three vertical dots on the
top right of the browser bar.

10. Select New incognito window.

-)p * O

7

Edit bookmark

Mame QBO and Chrome Tips & Tricks - Part 1 - it
Folder Bookmarks bar -
More... m Remove

To get your boockmarks on all your devices, turn

on sync.

Turn on SYNC..

or Tt

e
: ”

-
L]
]

Mew tab Cirl+T
Mew window , Ctrl+MN
MNew incognito window  Ctrl+5Shift+N
History k
Downloads Ctrl+)
Bookmarks »
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Features

Multiple Windows

Web-based applications utilize the functionality of web browsers. Imagine working in
several different windows in your QuickBooks Online company file. Log in to your
company data file (in this example we will use Google Chrome).

Right click the QuickBooks tab -> Duplicate. You now have multiple windows open
for your data file and can perform multiple tasks. This is a great way to enter and
review historical transactions during the setup or cleanup process.

@ CQuickBooks % -+

Mew tab to the right
< cC a
Reload Ctrl+R
TLG FF Apps_Websi .

Duplicate
Pin \
Mute site
Close Ctrl+W

Another way to access multiple windows is as follows:

1. After logging into QuickBooks Online go to the URL/address bar and copy (Ctrl +
C) the website’s address.

2. Then, open a new tab. Paste (Ctrl + V) this address into the window.

3. The tabs are as follows: first tab — Dashboard, second tab — Search, and
third tab — Bank Deposit.

@ CuickBooks ® @ Search ® | @ Bank Depasit X |

<« > (C & c23.gbointuitcom/app/homepage

Note: In Chrome you can create an additional user specifically for QuickBooks
Online. You can then save all your favorite tabs/pages and have them available
when you log in to your company data file.
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Features

Multiple Windows or Tabs

Using multiple windows is a great feature that allows you to work in two different areas of

the application on separate monitors. This feature can save a lot of time!

Follow these steps to open multiple windows. In this example, we'll use Google Chrome.

1.

Right-click the QuickBooks tab in your browser bar.

2. Select Duplicate.

v — m] X
@ QuickBooks X @ QuickBocks x |
o New tab to the right .
< C ¢ & appgbo.intuitcom/app/homepage o 2 * *» 0O o :
Add tab to reading list
-— Add tab to new group
T, =4¢ Sample Company o
qb qUICkbOOkS Move tab to another window » @ C)\ Q @
+ Reload Ctrl+R
. .
Pin
Mute site
>
Dashboard Get things done Busir
L0 Send to your devices
Banking =
E PRIVACY (
Close Curl+W \)
Sales Close other tabs
WORKSPACE Close tabs to the right

Customers & leads

Cash flow

Expenses E@
Payroll
Ac ucts
d services

Reports

customers

Another way to access multiple windows is as follows:

1.

2
3.
4

Log into QuickBooks Online.

Go to the URL/address bar and copy (Ctrl + C) the website’s address.

Then, open a new tab and paste (Ctrl + V) this address into the window.

The tabs are as follows: first tab — Dashboard, second tab — Search, and third tab —

Bank Deposit.

Note: In Chrome you can create an additional user specifically for QuickBooks Online. You

can then save all your favorite tabs/pages and have them available when you log in to your

company data file. Become familiar with this feature.
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Features

QuickBooks Online Mobile App

The QuickBooks Online Mobile App is very popular! It allows instant access to your
QuickBooks Online data from your mobile device. More and more business owners are on
the go and need easy and fast visibility to their accounting data. You can create multiple

types of transactions and attach supporting documents or photos from your mobile app.

» To get started, download the QuickBooks Mobile App to your Android phone,

iPhone, or tablet.

» Once you complete the installation, log in to your company file.

Here are some additional videos that will help you with Mobile App features. You may want

to return to this page to review videos as the need arises to access various features.

After you log into the app, log in to your company data file from a computer. Click the
search icon and select the transaction you just created from the app to add or change
information as needed. Verify the receipt photo/document is now available in the

attachments list.
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Setup Your Company File

Setup Wizard
Complete the following steps to successfully create your new Intuit QuickBooks
Online account.
1. Fill in the required fields -> Create Account -> Next.
If you have an existing Intuit account, click Sign in -> Username or Email ->
Password.
2. Verify your account. Click Continue.

Create your account

Already have an account? Sign In

Email address {(will be used as your user D)
Confirm email

First name

Last name

Phone {Recommended)

Password

)

Next, you will see a “Welcome! We're glad you’re here” window. Click Next.

17 QuickBooks Online Foundations
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Set Up Your Company File

3. For the Legal business name, use the exact legal business name used when

you set up your entity (to prevent problems with the IRS). Click Next.

What's your business name?

We'll use this to get you started in QuickBooks.

&~

Legal business name

‘ Craig's Design and Landscaping Services

4. Next, select the best option relevant to your situation. Are you importing from

QuickBooks Desktop, using another financial application, spreadsheets or other?

If you are not importing data, choose Nothing, I’'m just getting started. Click

Next.

How have you been managing your
finances?

No matter where you're coming from, we're here to help.

(v ] iR ey

Nothing, I'm just QuickBooks Other bookkeeping
Sage 50/Peacht
getting started Desktop™ 2 2 ESETMES software
@ ‘

Spreadsheets or pen

Oth
& paper =

No problem—we’ll walk you through setting up your business.

(oo ) N
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Set Up Your Company File

5. Search and select the industry specific to your business. This will auto-populate a
basic chart of accounts category list. You will learn how to manage your chart of

accounts later in the training.

w

Important! If you leave the field blank and click Skip for now, less account
categories will auto-populate. This will reduce the amount of time you spend on

customizing your chart of accounts.

What's your industry?

Start typing and select the option that fits best. You can always change it later.

naustry

Leave this field

|_ O\ blank

e W

6. Select the entity type used when setting up your business. Click Next.

What kind of business is this?

Tell us about your business structure. We use this to help categorize your transactions.

O & %
Non-profit
organization

Sole proprietor Partnership S Corp

= ©

CCorp I'm not sure

(=)
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Set Up Your Company File

7. Select the options that apply to your company. Do you provide services, sell
products, or both? Click Next.

How does your business make money?

We tailor your accounting categories based on your answer. Select all that apply.

Provides services

Sells products

Something else

(o) I

8. What is your role in the business? Select the option that applies, click Next.

What's your main role at Craig's Design and
Landscaping Services?

We'll customize QuickBooks based on your answer.

Owner or partner

(=)

[ . I
Bookkeeper or

Employee Other
accountant
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Set Up Your Company File

9. Who works at this business? Select the option that applies. Click Next.

Note: If you choose, Only the owner, you can always add payroll and contractor info

later.

Who works at this business?

Help us understand who's on your team. Select all that apply.

Only the owner

i

]

We plan to hire in
the future

R

Employees

=

Contractors

Afew partners and
owners

(o) N

10. Select No, | don’t want to add payroll.

@ Gickbooks

GET STARTED

The effortless way to pay your team

Free 30 day trial of QuickBooks Payroll

« Breeze through payday with direct deposit

« Payroll tax

« 24/7 expert support pr

+ Payroll syncs with QuickBooks so your books are always up-to-date

Want to add QuickBooks Online Payroll Premium?

o for 30 days
tenckonpar
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Set Up Your Company File

11. The next window that appears is based on your selections above. If you choose

employees, an option to add a payroll subscription will appear. Click | don’t want
to add payroll.

12. Next, click Skip for now. You can always connect third-party applications later.

What apps do you use for your business?

We'll help you connect them later on to bring in your data.

P (=) bill Dext

PayFal Square Bill.com Dext Prepare
amazon f
business Q@ g
Amazon Business Mailchimp

Start typing to select other apps you use

skip ornow AP

13. Link your accounts and see everything in one place. We will not actually connect
accounts for this course. Click Skip for now.

@ giickbooks

GET STARTED

Link your accounts and see everything in one
place

QuickBooks will automatically bring in ;:‘m r:“ =
transactions and save hours of manual $10,000
e Comme e

v el Falics

il
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Set Up Your Company File

14. What is everything you want to setup? Check all options to match the screen

shot below. Click Next or Skip for now.

What is everything you want to set up?

Your choices help personalize your setup. You can still use every part of QuickBooks.

@ QOrganize money in and out

D Invoice customers

i Track receipts & expenses

&] Pay employees or contractors

Track sales

j‘* lII Manage sales tax

@)

Accept online payments

Enter and pay bills

Track time

Manage inventory

Protect my business with insurance

Track mileage

15. We're almost ready to dive in! Click Let’s Go.

23

QuickBooks Online Foundations



@ Guickbooks.

There are two ways to view the left navigation bar:

Navigation

Click the gear icon then click Switch to Accountant or Business view. We will use

the Accountant View for the remainder of this training.

Left Navigation Bar

Business View

INTUIT

ab quickbooks.

MENU

(] Getthings done
Business
Banking
Get paid & pay
Customers & leads
Commerce
Payroll
Bookkeeping
Taxes
Pats

More (0)

BOOKMARKS

Bank transactions

Note: Your subscription may look slightly different depending on which version you

&

Left Navigation Bar

Accountant View

INTUIT

ab quickbooks.

Dashboard
Banking

Sales
Customers & leads
Cash flow
Expenses
Payroll
Reports

Taxes

Mileage
Accounting
My accountant
Capital
Commerce
Apps

Insurance

are using. It is also possible updates have been released.

QuickBooks Online Foundations
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Navigation

Left Navigation Bar (Accountant View)
This view is more specific to features related to the Centers. You do not have the
bookmark feature in this view. Note: This is a personal preference. You can switch

between the views, but we will use accountant view for this training.

Use the +New icon to manually input data for

INTUIT

ab quickbooks. customers, vendors, employees and other.

The links on the left side act as your menu bar and will
take you to frequently used areas in QuickBooks
Online.

Dashboard

Banking Post bank and credit card transactions in the Banking
Center.

Sales

View expense history and vendor information.

Customers & leads

Cash flow Access sales, customers and products from the Sales
Center.

Expenses

Payroll Manage projects and workers.

Reports Run payroll and track time.

Taxes

View and customize reports.

Mileage

Review and maintain sales and payroll taxes.

Accounting

My accountant Track your mileage.
Capital . . .
Maintain your chart of accounts categories.

Commerce

Invite an accountant or find a ProAdvisor.
Apps

Insurance Explore the application marketplace.

25 QuickBooks Online Foundations
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Navigation

Left Navigation Bar (Business View)

The Business view allows you to customize and bookmark centers and features. It

is a different view and way to organize your centers and features.

@b quickbooks.

MENU

{a] Getthings done
Business overview
Banking
Get paid & pay
Customers & leads
Commerce
Payroll
Bookkeeping
Taxes
Apps

More (0}

BOOKMARKS

Bank transactions

4

Use the +New icon to manually input data for
customers, vendors, employees and other.

The links on the left side act as your menu bar and will
take you to frequently used areas in QuickBooks
Online.

Post bank and credit card transactions in the Banking
Center.

View expense history and vendor information.

Access sales, customers and products from the Sales
Center.

Manage customers and leads.
Run payroll and track time.
Review and maintain sales and payroll taxes.

Customize the list, create and manage bookmarks.

Note: Click the pencil to the right of the “menu” in the left navigation bar to add or

remove centers. Click the pencil to the right of “bookmark” to add or re-order

bookmarks and pages.
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Navigation

Dashboard (Getting things done)
Once the new company setup process is complete, you will automatically land on
the dashboard (getting things done) tab. The icons shown in the screen shots below

are shortcuts to various areas of QuickBooks Online.

v = a X

@ QuickBooks x| +
&« C ()} @ appgbo.intuit.com/app/homepage = * » 0O o E
® Giickbooks [N Buwers @ QA 0 @ O
o + o . . .
+ New oeo  Craig's Design and Landscaping Services
Dashboard
ashboar ’ Get things done Business overview

Banking

WORKSPACE
Sales

Money in I}
Customers & leads 20
Cash flow [@ — —_— D — & A
Expenses
Add products Manage Create Send invoices Recsive Get funding
Payroll and services customers estimatas payments
Reports ‘ |
Taxes Money out
5 NEW
Mileage
O)— &
Accounting
Pay bills Business Track time Manage

My accountant e peyroll
Capital I
Commerce Accounting and reports Expert help

Apps ==
(P
Insurance & - &
T

Get business Seereports Manage taxes Telktoa

banking transections and trends bockkezper

Feel free to click and explore. You cannot hurt anything by navigating

through the clickable icons.
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Navigation

Dashboard (Business Overview)

Monitor the activity and status of your company, access your data and drill down to detailed
information with a simple click.
=+ Sample Company 8 My Experts @ Help O\ O @ o

_;30 Craig's Design and Landscaping Services

Get things done Business overview
Privacy (P
PROFIT AND LOSS Last 30 days ~ EXPENSES Last 30 days ~r BANK ACCOUNTS f
Checking
-$159 $158.85
MNet income for last 30 days Total expenses
2TO REVIEW
$0 Z ® 573.98 ‘
Income Automebile e
STOREVEL ® 565.90 0
e ® §18.97 o
Meals and Entert o
Visa
In QuickBooks 0
INVOICES SALES Last 30 days Connect accounts Go to registers v
$5,282 Unpaid Last 365 days
? ' $0.00
$5,282 $0 Total sales e Sales
Overdue Not due yet %1
. s
$0 Paid Last 30 days $0
$0 $0 50
Not deposited Deposited 51

_ Dec13 Dec1? Dec2é Jan02 Jan 09

-

You can access customers, vendors, transactions, and reports. You can also organize
and monitor bank and credit card accounts, review income and expenses, and watch
sales trends.

Tip: Click anywhere there is a word in bolded color, an icon, a drop-down arrow, etc.

Feel free to explore without worry!

Let’s begin!
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Navigation

Profit and Loss

This section of the
dashboard provides a
graph view of your

net income, income, and

expenses for the last 30 days.

Click the drop-down arrow
next to last month to change
the period for which the data
is displayed.

Sales
The sales section of the dashboard
displays a graph view of sales for

the prior month.

Click the drop-down arrow next to
last month to change the period

for which the data is displayed.

PROFIT AND LOS5 Last 30 days w»

-$159

Met income for last 30 days

A Ty e FIELA S

$0 /

Income

XPENSES

SALES Last 30 days -

$0.00

Total sales = Sales

29 QuickBooks Online Foundations
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Navigation

Income
The income section of the dashboard
allows you to view Invoices that are open,

overdue, and paid in the last 30 days.

Click the invoices color bars to view
and manage a detailed list of open invoices

currently owed to you by your customers.

Expenses

The expenses section of the dashboard
allows you to view a graph of expenses
broken down by amounts based on the

last 30 days.

Scroll your mouse over the graph to
create a pop-up of expenses related

to specific categories.

Click the drop-down arrow next to
last month to change the period for

which the data is displayed.

INVOICES

$5,282 Unpaid Last 365 days

$1,526 $3,756
Overdue Mot due yet
$3,692 Paid Last 30 days

$2,063 $1,630
Mot deposited Deposited

EXPENSES Last 30 days

$158.85

Total expenses

® $73.98

Automobile
® $65.90

Job Expenses

® $18.97

Meals and Entert...

P

30
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Navigation

Access and manage bank accounts from the dashboard. Turning on the Privacy

button will hide the bank balances. Change the order of how your accounts are

displayed and access registers. You can connect bank and credit cards accounts

here and in the Banking Center.

Bank accounts

Checking
Bank belance
In QuickBooks

Savings
Bank belance
In QuickBooks

Mastercard
Bank belance
In QuickBooks

Viza

In QuickBooks

&) rrvac (P
Z
362193 Upden
201.00
$200.00 Updat
$800.00 e

Connect accounts

Go to registers W

Note: The order displayed here will be the same in the Bank Center.
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Navigation

The +New icon in the left navigation bar provides access to data input windows.
This is where you go to create invoices, receive payments, enter expenses, checks,
bills and more. Although you will spend most of your time in the Banking Center, you

still need to know how to enter transactions manually.

Click the +New icon to create manual transactions.

CUSTOMERS VENDORS EMPLOYEES OTHER

Invoice Expense Payroll Bank deposit

Receive payment Check Time entry Transfer

Estimate Bill Journal entry

Credit memo Pay bills Statement

Sales receipt Purchase order Inventory gty adjustment
Refund receipt Vendor credit Pay down credit card
Delayed credit Credit card credit

Delayed charge Print checks

Show less

Tip: Always enter data from “top to bottom, left to right” to avoid missing fields that

require information.
Additional Icons include help, search, notifications and settings. Click the help

icon to address questions for specific areas of QuickBooks. Click the bell icon to

view recent notifications and the C icon to sign out.

& My Experts @ Help q Q @ G
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Navigation

The Search (magnifying glass) icon at the top of the dashboard will allow you to easily

search recent and historical transactions.

1. Click the Search icon. Q Q0 © 6

2. Enter a transaction number, date, amount etc. for a simple search.

= X

SEARCH TIPS Search for customers, vendors, transactions, reports, or accounts.

Search by name, address, amount (3340.00), date (MM/DD/YYYY) and more.

Type create to add a new invoice, expense, or any other kind of transaction.

RECENT Credit Card Expense | 01/05/2023 | $34.00

TRANSACTIONS
Credit Card Expense | Hicks Hardware | 12/17/2022 | $42.40
Credit Card Expense | Squeaky Kleen Car Wash | 12/23/2022 | §19.99
Credit Card Expense | Squeaky Kleen Car Wash | 12/16/2022 | $19.99
Credit Card Expense | Bob's Burger Joint | 12/16/2022 | $18.97
Credit Card Credit | 12/25/2022 | $900.00
Check Debit | Squeaky Kleen Car Wash | 12/09/2022 | $19.99
Cash Expense | Bob's Burger Joint | 12/07/2022 | $3.86
Cash Expense | Squeaky Kleen Car Wash | 12/02/2022 | $19.99

Cash Expense | Bob's Burger Joint | 12/02/2022 | $5.66

tonavigate enter toselect esc to dismiss | Advanced Search (D

3. Click Advanced Search to filter specific transaction types and more. Click the down-
arrows to the right of All transactions, Reference no. or Contains. to access

additional search options.

Sea I‘Ch yOLI r tra nsaCtiOI‘IS Go to classic Advanced Search or Send us feedback

Showing recent transactions

Additional Filters }{}

DATE TYPE REF NO. CONTACT AMOUNT

B I “ i | ¥ ]|

DATE ¢ TYPE REF NO. CONTACT AMOUNT ¢

01/15/2023 Credit Card $34.00
01/04/2023 Credit Card Credit $900.00
01/02/2023 Credit Card Squeaky Kleen Car Wash $19.99
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Navigation

4. Click the gear icon at the top right of your dashboard to access company

default settings, lists, and tools.

YOUR COMPANY LISTS
Account and settings All lists
Manage users Products and services

Custom form styles Recurring transactions

Chart of accounts Attachments
QuickBooks labs Custom fields
Tags

You're viewing QuickBooks in Business view. Learn more

Logo

TOOLS PROFILE
Order checks (§ Feedback
Import data Privacy

Import desktop data
Export data
Reconcile
Budgeting

Audit log
SmartLook

Resolution center

Switch to Accountant view

5. Click the logo icon to add your custom company logo from your desktop or hard

drive.

oeo Craig's Design and Landscaping Services
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Module 2 Doable Action Steps

All business owners should complete this section and apply the knowledge to their
own company file. Remember! You can always refer to various Modules of training if

you need additional reminders of how features works.

1. Review video links:
Billing and Subscriptions (1:38)
How to Use QuickBooks Mobile App (1:48)

2. Choose your subscription and signup if you have not already done so.

3. Explore these features:
Chrome — Clear your cookies and cache.
Multiple Windows — Create a duplicate window.
Mobile App — Go to the app store and install QuickBooks Online on your mobile
device.

4. Dashboard - Click through words in bold as well as icons, drop-down arrows,
etc.

5. Left Navigation Bar — Choose your view, then click on the Centers and explore.

6. +New — Learn how to navigate this menu and click through various options to
become familiar with the different fields per window.

7. Search - Become familiar with search filters.

8. Gear — Learn to navigate the gear menu and click through various options.
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@ Guickbooks.

Online Foundations

SECTION 2
SET UP YOUR NEW
QUICKBOOKS ONLINE
COMPANY

Goals

Account and Settings
Manage Users

Lists

Chart of Accounts
Action Steps
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Section 2 Goals

Upon completion of Section 2 each participant will be familiar with:

How to manage account and settings default preferences.
How to set up and manage users.
How to import lists.

How to set up and use the chart of accounts, and how it connects to all

transactions.
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Company Set-up is Vital

An accurate QuickBooks configuration is essential to effectively using the
accounting system. The initial set up will affect all future reports in QuickBooks. We

recommend you practice a company set-up from scratch.

QuickBooks is a very forgiving program. Most mistakes can be fixed, as you can go
back and make historical changes. However, a correct setup will prevent the need to

do so.

An accurate accounting software setup and optimized chart of accounts is
very important. After attending the training, if you need additional help
customizing the application to meet the unique needs of your business,

please reach out to your accountant for assistance.
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Account and Settings

Use Account and settings to turn on/off QuickBooks Online features. It is
important to turn off features you will not be using because it creates less fields
during the input process. It is OK to turn on features as the need arises. This
creates more efficiency and less guess work.

Although it is simple to turn settings on and off, it is important to set up your
company settings and data correctly. Seek help from your instructor/advisor if you

find you are “guessing.”

1. Click the gear icon to review, edit, and turn on/off settings.

2. Click Account and settings.

3. Click the Company tab in the left menu bar; YOUR COMPANY
. Com
then click the setting you choose to edit or Account and sattings !
click the pencil on the right side of the screen. s
Custom form styles Sales
Chart of accounts Expenses
Company Name QuickBooks labs F—

4. Add a customized logo, verify your company name, or add a legal name and
EIN to match the information on the company tax return. Click save anytime you

change settings.

Company name

Company name Craig's Design and Landscaping Services
Legal name

EIN/SSN
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Account and Settings

Company Type

5. Select the legal entity type you will use when filing your tax return, then select

industry type. Click save.

Ci t
ompanytype Tax form

Industry

Contact Info

6. Verify or edit contact info. Click save.

Contact info )
Company email

Customer-facing email

Company phone

Website

Address

Small business corporation, two or more owners (Form 11205)

Landscaping Services

intuieducation@intuit.com

+1 6509446000

intuit.com

7. Verify or edit your company address. Click save.

Add

ress Company address
Add

ress Customer-facing address
Address

Legal address

123 Sierra Way, San Pablo, CA 87999
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Account and Settings

Communications with Intuit

8. Click Marketing Preferences to allow or disallow promotional offers from Intuit.

Communications with

. Marketing Preferences
Intuit

Usage

Company
9. Click the Usage tab in the left menu bar.
This is where you monitor users and
account categories limits. If you reach the limits,

you will be required to upgrade your subscription.

Usage limits

Beginning April 2019, usage limits will go into effect and will depend on
your plan. Your current plan is QuickBooks Online Plus. Upgrade to have
greater capacity, or learn how to manage to these limits.

Learn more

Billable users 00F5

0 user(s)
The limit for your plan is 5.

Chart of accounts 44 OF 250
L]

44 account(s)
The limit for your plan is 250.

Tag Groups 0 OF40
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Account and Settings

Sales Settings Company
10. Click the Sales tab in the left menu bar.
11. Click the setting you choose to edit or

Sales

click the pencil on the right side of the screen.

Expenses

Advanced

Customize

12. Click Customize look and feel to customize invoices, estimates, and sales

receipts.

Customize

Customize the way forms look to your customers Customize look and feel

You can edit the existing standard template or create a new custom template.
13. Click New style.

14. Select Style and choose the type of sales form you would like to customize.
Select a template, add a title and logo, choose a color scheme, and preview the
form.

Let’s choose Invoice for this example.

Custom form styles

< All lists

NAME FORM TYPE LAST EDITED ACTION
Standard Mastar 05/11/2025 Edit W
New style W
Invoice
Estimate

Sales receipt
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Account and Settings

15. Select the Design tab to change your invoice template, add a logo, modify color

schemes, change font sizes, or print a sample.

16. Select the Content tab and then click on Invoice Form to change the header,

form name and numbers, or displayed information, or to add a customer field.

17. Select the Emails tab to change the outgoing email subject and default

message. Note: Do not overlook the reminder email feature.

18. Select the payments tab to add ACH and credit card payment options to your

sales forms. Note: This will require you to sign up for Intuit Merchant Services.

19. Click Preview PDF to review the sales form or click done.

Conen e

My INVOICE Template - 1-9 (28005)
L

Dive in with a template

Add your unique logo

Splash on some color

I:‘F Get choosy with your font

When in doubt, print it out
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Account and Settings

Sales Form Content

20. Click Sales form content to select and turn on/off settings for sales forms.

+ Preferred invoice terms sets the default payment date. "Net 30" means

payment is due 30 days from the date used to create the invoice.

* Preferred delivery method will allow you to set a preferred default to print

or send sales forms later.

Sales form content

Preferred invoice terms (%) Net 30 -
Preferred delivery method () Print later  w
Shipping @

Custom fields
Go to Settings > Lists » Custom Fields to manage your custom fields.

Custom transaction numbers ()

Service date (%) (j

» Shipping adds a shipping field to sales forms.

+ Custom fields can be added and managed in gear settings -> lists ->

custom fields.

+ Custom transaction numbers allows you to choose your own numbering

system.

» Service date creates a service date field. This tracks the dates services

were performed when they are different from the invoice date.

Note: When you turn on the Shipping feature, be sure to add the default shipping

account category in the advanced->chart of accounts settings.
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Account and Settings

Sales Form Content Continued
» Discount will add a discount field to invoices.
» Deposit adds a deposit field to invoices and allows you to offset the balance
owed with amounts paid before the service was completed.

Note: Once you turn on Discounts, you will need to add a discount account in the
advanced -> chart of accounts settings.

» Accept Tips - Adds a tips field to sales forms. Select (Just Me) to record tip
income or select (My Team) to track tips that need to be paid out to your team.

Discount (3)
Deposit ()

Accept tips (@

Note: Once you turn on Accept Tips you will need to add a Tip Income (Just Me)
account or Tips Payable (My Team) account in the accounts and settings->advanced-

>tips payable account.

Who's receiving these tips?

+ Tags allow you to create tags and tag groups to customize the way you track
information. (Recommended feature we will cover in more detail later in the

training.)
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Account and Settings

21. Click Products and services to turn on/off desired settings.

Show Product/Service column on sales forms adds a column so you
can choose from the list of products or services.

Show SKU column allows you to track products and services by SKU
number.

Turn on price rules allows you to provide discounts for specific products
to certain customers for a specified amount of time.

Track quantity and price/rate adds a field to show quantities and pricing
on sales forms.

Track inventory quantity on hand allows the tracking of products you
buy, store and sell.

Products and services Show Product/Service column on sales forms Cn
Show SKU column On

Turn on price rules off

Track quantity and price/rate On

Track inventory quantity on hand Cn

+ Late fees allow you to automatically apply a flat fee or percentage to

outstanding invoices. Select Default charge applied to overdue invoices
to turn this feature on. Select flat fee or percentage of remaining balance
and continue to select the required information. Click save.

Late fees Default charge applied to ocverdue invoices Off
Appears az a line under Product/Service on the invoice
and applies to all customers. Learn More
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Account and Settings

Progress invoicing

22. Progress invoicing allows you to create multiple partial invoices from a single

estimate. (This feature is great for contractors providing services for new

construction.)

Progress Invoicing Create multiple partial invoices from a single estimate Off

Messages

23. Click Messages to add a default email message sent with sales forms, invoices,
estimates, credit memos, sales receipts, statements, and refund receipts.

» Click Email me a copy to receive a copy of emailed sales forms.

Default email message sent with sales forms
|2| Use greeting| Dear || [Full Name] ¥
Sales form (@
Email subject line
Invoice from Craig’s Design and Lands:

Email message

Your invoice is attached. Please remit payment at your earliest convenisnce.

Thank you for your business - we apprediate it very much.

Sincerely,

Craig's Design and Lendscaping Services

Email me a copy at noreply@quickbooks.com
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Account and Settings

24. You can include a Cc or Bcc email as well. Your default message sent with sales

forms can be changed when creating estimates, invoices and other sales forms.
Copy (Cc) new invoices to address

Blind Copy (Bcc) new invoices to address

S ) m

Note: A default email message sent with reminders is also available.

25. Click Reminders to change the default subject and email message. Turn on

Automatic invoice reminders and let the system do the work for you.

Reminders Default email message for invoice reminders

Use [Invoice No.] and [Company Name] as placeholders in the email.

Subject line

‘ Reminder: Your payment to Craig's Design and Landscaping Servi ‘

Use email greeting | Dear v ‘ ‘ [Full Name] v |

Email message

We're sending a reminder to let you know that invoice [Invoice
No.] has not been paid. If you already paid this invoice or have
any questions, let us know!

Have a great day,
Craig's Design and Landscaping Services

‘_‘ Send a copy to noreply@quickbooks.com

Automatic invoice reminders w\) ’
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Account and Settings

Online Delivery
26. Click Online delivery to attach sales forms as a PDF, show summary or detail,

and change your email text preference.

Online delivery Email options for all sales forms

@ Show short summary in email

Show full details in email

PDF Attached

Additional email options for invoices

Flaintext =

Statements
27. Click Statements to change settings to display all your customers’ unpaid
transactions by a single line item or include detail.
« Show aging table displays outstanding balances by days delinquent at
the bottom of the statement.
» Send a courtesy statement when customers are no longer current. Click

Save->Done in the bottom right corner.

')

Statements @ List each transaction as a single line (@

List each transaction including all detail lines

Show aging table at bottom of statement (2) (;-
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Account and Settings

Expenses Company
28. Click the Expenses tab in the account and settings
menu bar and then click the setting you choose to edit
or click the pencil on the right side of the screen. Expenses
Bills and Expenses
29. Click Bills and expenses to turn on/off settings, add columns on forms, and track
expenses.
+ Show Items table on expense and purchase forms adds products column to
forms.
» Show Tags field adds a field that allows you to track transactions using tags
and tag groups.
+ Track expenses and items by customer adds a column to track transactions
by customers.
+ Make expenses and items billable adds a column to track expenses billable to
the customer and gives you the option to add a default markup rate.
» Track billable expenses and items as income allows you to use one or
multiple income accounts to track billable expenses. Note: Go to advanced >
chart of accounts > billable expenses income account.

» Default bill payment terms is used to set default terms for bills, such as net 30.

Bills and expenses Show Items table on expense and purchase forms (@ (;-
s Tag xpe form [ @)
I with of
| Track axp d item m
(]

Default bill payment terms

o QI '
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Account and Settings

Purchase Orders

30. Click Purchase orders to turn on/off Use purchase orders and create custom
fields.

Purchase orders are used to track product purchased from vendors. This is helpful

when tracking open orders for inventory and in comparing costs to actual bills.

+ Custom fields allow you to add extra fields to purchase orders to track
information using custom reports.

+ Custom transaction numbers allow you the option to use your own
numbering system. If this is not checked, QuickBooks Online will
automatically assign a number.

+ Default message on purchase orders adds a default message to all
purchase orders. This can be changed when adding new Purchase Orders
in QuickBooks Online.

Purchase orders Use purchase orders a
Custom fields
Go to Settings > Lists » Custom Fields to manage your custom fields.
Custom transaction numbers !:':'_.'

Default message on purchase orders

Note: Click messages to change outgoing email messages specifically for
purchase orders. Click Save -> Done.
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Account and Settings

Payments Tab
31. This is where you manage your QuickBooks Online and merchant service

subscriptions.

Time
32. Click Time to turn on/off and edit settings.
» First day of work week sets the starting day of a work week on the

timecard entry form.

General First day of work week Mondaey ¥

I Cance' Im

» Add service field to timesheets is a field used to enter specific services
performed.

» Allow time to be billable is a feature that tracks billable time by customer.

» Show billing rate to users entering time allows users to view the rates

you use to invoice customers.

Timesheet Show service field (@) (;'
Allow time to be billable (@) (:'

o

| o) T : : e
| | Show billing rate to users entering time 1)
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Account and Settings

Advanced

33. Click Advanced in the account and settings menu bar Company
and then click the setting you choose to edit or click
the pencil on the right side of the screen. e

34. Click Accounting to turn on/off and change settings.

Expenses

» First month of fiscal year is usually January, based on the calend e
Some companies use a different month to start their fiscal year.

» First month of income tax year lets you click the drop-down arrow to select
January or Same as fiscal year.

» Accounting method includes two Accounting methods for running reports:
accrual and cash. If you use accounts receivable and/or accounts payable in
QuickBooks Online, then choose the accrual basis. If not, then use the cash

basis.

Accounting First month of fiscal year @ Jenusry v

Accounting method (3) Accrual ¥
» Close the books is a great feature that allows you to close a period and assign
a password. Turning on this setting triggers a warning box that prevents users
from changing historical data, especially important when sales, payroll, and tax
returns have been filed.

Close the books (2) (J

Closing date
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Account and Settings

Company Type

Tax Form

35. Click the Tax form drop-down list to select the entity type you used when filing
your company’s tax return. If you are unsure about this, contact your

accountant.

Company type Tax form () Mot sure/Other/MNaone =

Not sure/Other/None ‘

Sole proprietor (Form 1040)

Partnership or limited liability company (Form 1065)

Small business corporation, two or more owners (Form 11205)
Corporation, one or more shareholders (Form 1120)
Nonprofit organization (Form 990)

Limited liability

Not sure/Other/None

Chart of Accounts
36. Click Chart of accounts to turn on/off account numbers and assign default
income accounts. This allows business owners to organize their chart of

accounts categories in a way that is meaningful to them.

Chart of accounts Enable account numbers @ (\‘

Show account numbers (2)

Discount account (@ Discounts given v
Tips account (2) v
Billable expense income account (@) Billable Expense Incom | v
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Account and Settings

Categories: Classes

Classes allow you to track transactions in order to gather data and review reports

by a specific class.

For example, Craig’s can track commercial vs residential jobs, or jobs per city to
determine sales by city for state license reporting. The use of classes provides the

capability to review profit & loss by class.

37. Click the appropriate box to turn on Track classes. Then click Warn me when a
transaction isn’t assigned a class. This will create an alert when the class
entry is missed during the data entry process.

» Assign classes gives you the option to assign classes to a transaction or

to individual line items.

. - P b
Categories rack classes (2 [ @)
|| Warn me when a transaction isn't assigned a class

Aszsign classes
One 1o each row in transaction ¥

— = i
rack locations (2)
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Account and Settings

Locations
38. Track locations is used to gather data for a specific location, department,
property, etc. Not all businesses need to use locations. An example; Craig’s

could use locations to track sales by county or sales by property address. This

provides the ability to review a profit & loss by location. Locstion ¥
] Businesss
Track locations (2 | @)
Location label Department
D
Location ¥
Location
Territory
Automation

39. Click Automation to turn on/off settings for pre-filled forms, apply credits, and
more.

» Pre-fill Forms with previously entered content fills form fields with
memorized content from prior vendor, customer, and employee
transactions.

« Automatically apply credits posts outstanding credits to newly created
invoices.

« Automatically invoice unbilled activity creates an invoice for tagged
transactions waiting to be billed to a customer. When the invoice is
generated, an alert is sent to the activities section of the dashboard.

« Automatically apply bill payments applies bill payments to the oldest

open bill first.
Automation Pre-fill forms with previously entered content Off
Automatically apply credits Off
Automatically invoice unbilled activity Off
Automatically apply bill payments Off
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Account and Settings

Projects
40. Turning on Projects allows you to organize all job-related activity in one place. It allows
you to review all sales, expenses, and time by project. Here we can track information from

a cost perspective.

P

Projects COrganize all job-related activity in one place (

Currency

41. Multicurrency lets you track transactions in foreign currencies. Use it only if you have
bank accounts, customers, or vendors that do not use your home currency. Otherwise,
select the default, Home Currency. Warning! Once you select a home currency, you will

not be able to change the currency.

Currency Home Currency USD - United States Dollar

Multicurrency (@ (:'
Multicurrency may be right for you if you have financial
transactions in more than one currency.

Meed help deciding about multicurrency?

Once you turn on Multicurrency:

hange your home currency

s Extrs fields, columns and more are added 1o
QuickBooks

* Some festurss may no longer be available

|_| | understand | can't undo Multicurrency

| Cancel

Note: Once you turn this feature on, you cannot turn it off or change your home currency.
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Account and Settings

Other Preferences

42. Click Other preferences to turn on/off and edit settings that trigger warnings

and formatting preferences.

Date format is a preference with several options.

Number format is a personal preference.

Customer label reflects the type of customers you service or sell to. The
label you choose will appear on the navigation menu bar and transactions
related to customers, such as invoices, sales orders, credit memos, etc.
Warn if duplicate check number is used populates a warning box when
a duplicate check is entered.

Warn me when | enter a bill number that’s already been used for that
vendor populates a warning box when a duplicate number is used.

Warn if duplicate journal number is used populates a warning box
when a duplicate journal entry number is used.

Sign me out if inactive for a period. It let's you choose between 1 and 3

hours. Click Save -> Done.

Other preferences Date format MM/dd/yyyy
Mumber format 123,456.00
Customer label Customers
Warn if duplicate check number is used On
Warn me when | enter a bill number that's already On

been used for that vendor
Warn if duplicate journal number is used On

Sign me out if inactive for 1 hour
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Manage Users

When inviting users, you can determine how much or little access a user has to your
company data. Maintaining user access is important to implement checks and
balances and view activity by user. This can serve as a training tool to address and

avoid common errors.

1. Click the gear icon -> Manage users.

2. Select the Users tab to add and customize a user or select the Accounting
firms tab to invite your accountant.

The initial user is known as the primary admin. If you want to transfer this role to

another user, set them up as an admin user and use the action drop-down menu to

transfer the rights to the new user. The new user will receive an email notification.

Manage users ( cive Feedback )

o

Users(®  Accounting firms ()

X

NAME EMAIL USERTYPE STATUS DATE ADDED BiLLaBLe (D ACTION

MNo data available

Note: You can add up to two accountants to your QuickBooks Online data file
in addition to the number of users your subscriptions allow. In order to do this,

your accountant must subscribe to QuickBooks Online accountant.
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Manage Users

3. Click Add user to add a new user.
» Standard user will allow you to select which areas a user can access.
« Company admin has access to all areas of QuickBooks Online Plus.
* Reports only will allow users access to most reports; the exceptions are
payroll and contact info. They do not count toward your user limit.
« Time tracking only limits users to entering their time. They do not count
towards your user limit.

4. Click Next and follow the screens until you have successfully added a user.

Add a new user

Select user type

These count toward your user limit.

@) Standard user

These don't count toward your user limit.

Reports only

= reporis, except ones that show payroll or contacl into.

ime tracking only

ney can adc their own otme sne

1]
o

Note: User options may be limited depending on the type of subscription. This

example is based on the Plus version of QuickBooks Online.
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Manage Users

5. Continue to click Next until you complete the Add user process.

Note: A box appears with a list of access rights based on your selection.

Add a new user

Select access rights

How much access do you want this user to have?

@ All
MNone

Limited

6. For those with a Plus subscription, you will have the ability to set the

administrative rights for specific users.

Add a new user

Select user settings

Do you want this user to add, edit, and remove users?

Yes

® No
View only

Do you want this user to edit company info?
Yes

@ No

Do you want this user to manage subscriptions?
Yes

@) No

View only
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Manage Users

7. Enter username and email information; an invite will be sent to the user. They

will be invited to accept the invite and create a password.

First name
Last name

Email

o

This will be their user id.

8. To invite an accounting firm with administrative rights to your company data,
from the manage users main screen click accounting firms if your accountant
subscribes to QuickBooks Online Accountant.

9. Enter your accountant’s email address and ask your accountant to accept the

invite.

An accountant can be your best business partner

Make it easy to work together. Invite yours to your QuickBooks.

Invite

Your accountant and members of their firm will have admin

access to your company data.
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Lists

Lists are one of the basic features of QuickBooks Online. Lists are triggered when

turning on features in account and settings. A list is a series of like information

compiled into an organized directory. This helps save time and ensures that

information is entered consistently and correctly.

1. Click the gear icon.

2. Click all lists -> Select the list you would like to maintain.

Lists

Chart of Accounts

Dizplays your accounts. Balance sheet accounts track your assets
and liabilities, and income and expense accounts categorize your
transactions. From here, Yyou can add or edit accounts.

Recurring Transactions

Displays a list of transactions that have been saved for reuse.
From here, you can schedule transactions to occur either
automatically or with reminders. You can also save unscheduled
transactions to use at any time.

Products and Services
Displays the products and services you sell. From here, you can
edit information about a product or service, such as its
description, or the rate you charge.

Product Categories

A means of classifying items that you sell to customers.
Provide a way for you to quickly organize what you sell,
and save you time when completing sales transaction
forms.

Locations

You can use locations to categorize your transactions by different
parts of your company.

Custom Form Styles

Customize your sales form designs, set defaults, and manage
multiple templates.

Payment Methods

Displays Cash, Check, and any other ways you categorize
payments you receive from customers. That way, you can
print deposit slips when you deposit the payments you
have received.

Terms

Displays the list of terms that determine the due dates for
payments from customers, or payments to vendors. Terms
can also specify discounts for early payment. From here,
you can add or edit terms.

Classes

Displays the classes you can use to categorize your
accounting transactions.

Attachments

Displays the list of all attachments uploaded. From here
you can add, edit, download, and export your attachmenits.
You can also see all transactions linked to a particular
attachment.

Custom Fields

Sort, track, and report the information that matters to you.
Add custom fields to your forms so that you can capture
more business-related info.
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Lists

Importing Lists

You can import list information from Excel or Google Sheets to save time. You can
import customers, vendors, accounts, and products and services. You can download

a sample file to see how to set up your import file.
3. Click gear icon -> Import Data.

4. Click on the icons to access and download the sample CSV, Excel, or Google

template. You can download or preview a sample file to get started.

Import Data

Bring your existing data into QuickBooks

Bank Data Clients Vendors Chart of Accounts Products and Services

First time importing your Chart of Accounts?

s All your Chart of Accounts information must be in one file

* The top row of your file must contain a header title for each column of information

Select a CSV or Excel file to upload Select Google Sheet

Upload an EXCEL or CSV file | [ Browse I | Cennect Google Sheets™ web-ba:

Download a sample file 4% Preview a sample

©2018 Google LLC All rights reserved. Google and the Google logo are registerad trademarks of Google

LLC.

Note: What type of lists can be imported? Review above.
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Chart of Accounts

The chart of accounts is a list of categories that make up your Balance Sheet and
Profit & Loss Statements. Every transaction entered in QuickBooks will post to the
accounts list. This is how data is compiled to produce important reports used to
manage a business.

Balance Sheet
Assets (what your company owns): bank accounts, petty cash, fixed assets
(equipment or vehicles), inventory, undeposited funds (payments from customers
waiting to be deposited).
Liabilities (what your company owes): accounts payable, loans, sales, payroll
taxes.
Equity (the net worth of your company): Money that owners contribute to or draw
from the business and an accumulation of net profits and losses from the start of the
business to present or sale.

Profit & Loss
Income (what you have earned): sales of products, labor, interest, rental income,
materials, etc.
Expenses (what you have spent): office expenses, wages, professional fees, rent,
utilities, etc.
The Profit & Loss Statement shows the net loss or gain for a period. At the end of a
calendar or fiscal year, the net profit or loss rolls into the equity section of the
Balance Sheet.

Note: Keep your chart of accounts simple. Add new accounts when you need to
track specific information. Use reports to customize information within an account.
Discuss account changes with your accountant. Start by adding bank and credit
card accounts.
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Chart of Accounts

Manage Accounts

1. Click the gear icon -> Chart of Accounts or left navigation bar -> accounting -
> Chart of Accounts.

2. Click view register to manage transactions for a specific account.

3. Click the drop-down list to edit, make inactive, or run reports.

4. Click the header name to sort by column.

Chart of Accounts Run Report m
<€ All Lists

NAME TYPE DETAILTYPE BANK BALANCE ACTION

Checking R Bank R Checking -3,621.93 View register [+]

Savings w, Bank Wy, Savings 200.00

Make inat e duces usage
Accounts Receivable (A/R) Accounts receivable (A/R) Accounts Receivable (A/R) ——p R

un report

. Type an account name in the Filter by name field to search for an account.
. Select Show all or categories that count towards your usage limits.
. Click the pencil icon to edit multiple chart of account names.

. Click the printer icon to print a list of your chart of accounts.

© 00 N O O

. Click the gear icon to add/remove display columns, change the number of rows,

or include inactive accounts.

Note: Remember to turn on account numbers in accounts and settings if you want

to customize the organization of your chart of accounts.
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Chart of Accounts

Add Accounts

1. Click New or the drop-down list to Run Report m
add an account or import from a .csv file. Import

. Create a new account and name it Ask My Accountant.

. Select the Account Type Expenses and the Save account under to Other Expenses.

. Select the Tax form section other miscellaneous expense.

a A WODN

. Change the account name to Ask My Accountant.
This will position the account at the bottom of your Profit & Loss Statement, where it will
stand out as a reminder to address or research questionable transactions before
processing financials for the month or year.

6. Click Save and New to add another account or Save and Close to return to the chart of

accounts list.

New account X

s (a)a & o o

Income Expenses Banks Assets Credit Liabilities

Save account under *

Other Expenses ~
Q p

Tax form section * ()

‘ Other Miscellanecus Expense v ‘

Account name *

‘ Ask My Accountant ‘

Description

Note: Home Depot and Walmart are not account categories. They are vendors used to
purchase supplies and materials (supplies and materials are account categories).
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Chart of Accounts

Add Bank Accounts

New account X
In this example we are setting up i ) R
= B
a neW bank aCCOunt. Income Expenses Banks Assets Credit Liabilities
~
Equity
1. Click New from the
Save account under *
chart of accounts List. | @ Bank Accounts v |
2. Select the account type icon. Taxform section *
. ‘ Checking v ‘
3. Select the Save account under. This is
Account name *
where you can add an account to a Checking 100K |
group of accounts.
4. Select the Tax form section.
X
5. Type the Account name. New account
| Checking XXXX | -
Description
w Starting date and opening balance
More info on opening balances
Add an optional description g
You have the option to add a
Beginning of this year
is important in case you need to B eginning of this month LENACEOU IR
merge accounts in the future. o
1 Other date
[ 1,201.00
Checking XXXX
Savings 800.00

Ca nce' m
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Chart of Accounts
Edit Account
From the chart of accounts list locate the account you would like to edit.
In this example: The loan payable is a five-year vehicle loan and should be
categorized as a long-term liability. Current liabilities are usually paid within a year;
examples are sales and payroll taxes, lines of credit etc.

From the action menu column, click the drop-down list-> edit.

Arizona Dept. of Revent Other Current Liabi... | Sales Tex Payable
Edit

Board of Egualization Pi Other Current Liabi... = Sales Tax Payable Make inactive (reduces usage)
Run report

Loan Payable Other Current Liabi... | Other Current Liabi...

Use the Account type drop-down list to change the Save account under type from
Other Current Liabilities to Long Term Liabilities. Change the Tax form section to
Notes Payable and change the name and description to be more specific. Remember
to click Save and Close.

Edit account x

& B8

Income Expenses Banks Assets Credit Liabilities
cards

Save account under*

‘ Q_ Long Term Liabilities v ‘

Tax form section * )

Notes Payable v }

Account name *

‘ Loan Payable ‘
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Chart of Accounts

Make Inactive

From the chart of accounts list:

1. Click one time to highlight the account you would like to inactivate.

For this example, we will inactivate the Miscellaneous account.

Miscellaneous Other Expense

Penalties & Settlements Other Expense

2. Click Make inactive in the action column drop-down list.

3. An “alert” will pop up and ask you to confirm. Click Yes.

o Are you sure you want to inactivate this?
I: No :I

The Miscellaneous account will no longer appear in the
chart of accounts list. However, the account is technically
inactive and will appear on the list when you choose

Include inactive from the gear icon.

Other Miscellaneous Expense

Penalties & Settlements

Run report B
Edit

Make inactive (won't reduce usage)

g <] ©
-
2 3
D 3

Detsil Type
|Z QuickBooks Balance
[v] Bank Balance
Other
B include inactive
Rows

70

QuickBooks Online Foundations



@ Guickbooks.

Chart of Accounts

Merge Accounts
Merging accounts is helpful if two or more accounts are being used for the same
types of transactions and you want to combine the transactions into a single

account.

Caution: The merge process cannot be undone and is permanent. It is important to
confirm that the merge process will not affect the financial statements used to file
tax returns.

It is advisable to discuss the cleanup of your chart of accounts with your instructor,
accountant or QuickBooks ProAdvisor before merging accounts.

In this example we have two accounts being used to track office expenses.

We will merge Accounting with Bookkeeping from the chart of account settings
window.

1. Click one time to highlight the account you will keep, “Accounting.”

2. Click edit from the action column drop-down list.

Legal & Professional Fed Expenses Legal & Professional Fees
b | =
Accounting Expenses Lagal & Professional Fees
Boockkesper Expenses Leqgal & Professionsl Fees
o |
Lawyer Expenses Leqgal & Professionsl Fees
i o |

Note: The save account under and tax form section must be the same for
accounts you intend to merge. When merging sub-accounts, both accounts must be
a sub of the same parent account.
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Chart of Accounts

3. Highlight the name Accounting and copy (Ctrl + C) the account name.

4. Click the cancel button in the lower left to return to the chart of accounts settings list.

Save account under *

‘ Q_ Legal & Professional Fees v ‘

Tax form section * (&)

‘ Legal & Professional Fees v ‘

Account name *

Accounting ]

5. Select the account Bookkeeper.

6. Click edit from the action column drop-down list.

Save account under *

‘ Q, Legal & Professional Fees v ‘

Tax form section * O

‘ Legal & Professional Fees v ‘

Account name *

| |

7. Highlight the name Bookkeeper and Paste (Ctrl + V) to replace “Bookkeeper” with

“Accounting.” Click Save -> Yes.

Account name *

Accounting

A Merge accounts?
You already have an account with that name. Would you like to merge

the two?

Cancel | Yes, merge accounts
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Chart of Accounts

Sub-accounts

Sub-accounts are a great way to organize your chart of accounts when used properly.

It is important to select sub-accounts in all transactions and avoid using the main account.
1. Click New from the chart of accounts list.

For this example, we will create sub-accounts for automobile expenses.

Note: The Save account under (parent account) will be “Automobile”, the Tax form
section will be “Auto”, and the Account name is “Fuel”’. Repeat the process to create

additional subaccounts for license, and service.

Save account under *

‘ Q_ Automobile v ‘

Tax form section * (&)

‘ Auto v ‘

Account name *

‘ Fuel ‘

Now that you have created a main account for Automobile and sub-accounts for Fuel,

License, and Service, the chart of accounts should look like this:

Automobile Expenses Auto
Fuel Expenses Auto
License Expenses Auto
Service Expenses Auto
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@

Beginning

Balances

It is important to verify or enter beginning balances and historical data. Your

accountant can assist you in using a journa

balances when adding bank accounts to yo

If you have converted data, then you would

| entry or you can add beginning

ur chart of accounts list.

have compared a Balance Sheet and

Profit & Loss Statement (set for all dates and accrual basis) in QuickBooks Online

with the same reports in the accounting application you were using.

Enter beginning balances when setting up a new bank account, credit card account,

and other assets and liabilities. Opening balances default to open balance equity in

the chart of accounts.

New account

. @ = -

Banks Credit
cards

Income Expenses Liabilities

Save account under *

‘ Q_ Bank Accounts

Tax form section * ()

‘ Checking

Account name *

| Checking XXXX

New account X
‘ Checking XXXX ‘ -
Description
w Starting date and epening balance
v
Beginning of this year
B
Ba Beginning of this month
Today
Bz
Other date
[ 1,201.00
Checking XXXX
Savings 800.00
[=]

Note: Accounts receivable (customer invoices) and accounts payable (unpaid

bills) should be entered individually to match beginning balances.
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Beginning Balances

Journal Entries are used to record beginning balance transactions, or transactions

that occur outside of the business bank and credit card accounts. QuickBooks

automatically enters the date and journal entry number, but you can change them

anytime. You must enter at least two accounts and at least one debit and one credit,

in order to save the journal entry. The debit and credit totals must match.

1. Click +New -> Journal Entry.

2. Verify the date and journal number. Enter the account, amounts, description and
name if applicable.

3. Click Save.

(S Journal Entry #AJEO1 Balance Sheet 6 (2) Help

Journal no.

AJEQ1 Belence Sheet

ACCOUNT DEBITS CREDITS DESCRIPTION NAME LOCATION CLASS

10 34 30,250.25 To record beginning bslan San Diego Genera

2 10100 Payrol 5678 To record beginning balance San Diege Genera
3 - 10200 Sevings 9101 10 To record beginning balancs San Diego Genera
12000 Inventory Asset 7,938.26 To record beginning balance San Diege Genera

5 - 15000 Furniturs & Fixtures 752067 To record beginning balancs San Diego Genera
15100 Machinery & Equipment 2527623 To record beginning balance San Diege Genera
15200 Vehicl 119,615.59 To record beginning balancs San Diego Genera

8 = 16000 Accumulsted Depreciat 68,725.22  To recard beginning balance San Diege Genera
ment 3531287 To record begin San Diego Genera

17500 Accumulated Amonizesi 603524  To record beginning balance San Diege Genera
19000 Security Deposits To record beginning balancs San Diego Genera

2 . 21000 Chese 1125 593231 To record beginning balance San Diege Genera
3 23000 Line of Credit 1946-01 15,026.27  To record beginning balance San Diego Genera

Note: What is required to create a journal entry? Accountants typically provide
adjusting journal entries when completing the tax return. For example, depreciation
expense is used in conjunction with fixed assets. We depreciate assets over specific

periods of time.
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Historical Transactions

Entering Historical Information
When you start a new QBO file, you may need to enter historical data. Use the

following process for each area of the business:

Accounts Receivable — Enter transactions (invoices, incoming payments, and
deposits) in the same order and date they were created or received. This process

creates a historical record of transactions by customer.

Invoice — Click the +New icon -> invoice and enter each invoice sent between
your start date and today. Be sure to use the correct dates as well as the products

and services list.

Receive Payment — Click the +New icon -> receive payment and enter all
payments received from customers between your start date and today. When
payments are received, they are posted to a default holding account known as

undeposited funds.

Bank Deposit — Click the +New icon -> bank deposit to select payments and post
deposits to the bank register. This is a very important step intended to group
payments that match the deposit sent to the bank. This step clears out the

undeposited funds holding account.
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Historical Transactions

Accounts Payable — Manually enter bills and bill payments in the same order and
date they were created or paid. This process creates a historical record of
transactions for a vendor.

Bills — Click the +New -> bill and enter any outstanding bills.

Pay Bills — Click the +New -> pay bills to attach payments to bills.

Bank Transactions — If you are entering historical transactions for more than a
one-month time frame, enter the transactions one month at a time and reconcile all

bank and credit card accounts before going on to the next month.

There are three ways to enter historical bank transactions: manually, using the

import feature or connecting bank accounts (per Module 2 training).

Use the following process to enter bank transactions:

1. Manually enter all checks by clicking the +New icon -> check and entering all
checks posted one month at a time.

2. Manually enter debits by clicking the +New icon -> expenses and entering all
debits posted to the bank one month at a time.

3. Connect the bank account to QuickBooks Online — dashboard -> connect
accounts or banking -> add account and follow the setup process. Use
caution when selecting the period to download transactions to avoid duplicate
transactions.

4. Export and import transactions from your bank to QuickBooks Online.

5. Complete bank reconciliation — Click the gear icon -> reconcile. Deposits and

bill payments should already be posted to the register.
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Historical Transactions

In this example, we created a journal entry to record the purchase of a truck and
corresponding loan. You will see that it increases assets and liabilities on the
Balance Sheet. We record beginning bank balances to reflect accurate cash on

hand. Legal and license fees increase the expense categories on the profit & loss.

If personal accounts were used by the business owner prior to setting up the
accounting application, this shows how to enter those transactions. Since the owner
paid out of their personal accounts, we post the total to owner contributions which

increases the equity section of the Balance Sheet.

() Journal Entry #AJEO1

Journal date Journal no.

12/01/2022 LJEDT

# ACCOUNT DEBITS CREDITS DESCRIPTION NAME
10000 Checking 1234 50,000.00 Te record beginning balance

2 10200 Savings 1537 1,000.00 Te record beginning balance

3 | 10800 Register Drawer 200.00 To record beginning balance

4 10800 Register Drawer 200.00 Te record beginning balance

5 ' 10900 Petty Cash 500.00 Te record beginning balance
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Section 2 Action Steps

1. Watch the video links:

3.

How to Set Up Company Settings (2:37)

How to Add and Manage Users (3:55)

How to Customize Invoices and Sales Forms (4:36)

Understanding the Chart of Accounts (4:20)

How to Add Accounts to your Chart of Accounts (3:17)

. Review your company and account settings and turn on/off features that are

specific to your company. Turn off anything you do not currently need. If you are
unsure about what settings you need, talk to your instructor/accountant.

Add users (bookkeeper, tax professional, etc.).

4. Customize your chart of accounts.

Information that may help - Remember Office Depot, Costco, Walmart, etc. are
not account categories, they are vendors. Another example, office expense can

include postage, supplies, printers etc.
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Section 2 Action Steps

Important to note: Your subscription will auto-populate the chart of accounts
categories based on the industry you choose in the setup process.

We recommended leaving the industry blank during the setup process.

Here are two options when determining your approach to setting up your custom chart

of accounts list. Be sure to turn on “enable account numbers” in account and settings.

Option 1:
Manually add, edit, merge or inactivate accounts to create your own custom
chart of accounts. Refer back to this section of the training for a refresher. This is the

best option if you have been using an existing chart of accounts list.

Option 2:

Use the “batch actions” feature to inactivate multiple accounts at once. Simply
check the box to the left of the category you would like to inactivate, then select the
batch actions drop down -> make inactive. Then import a pre-populated excel list.

Refer to the import process of this training for guidance.

it

Important! There will be several account categories you will not be able to inactivate.
They are default categories that work with other features of the application. For

example: uncategorized assets, uncategorized expenses, and sales. Ignore them!
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Online Foundations

SECTION 3
REPORTS

Goals

Balance Sheet
Profit & Loss

Ask My Accountant
Audit Log

Action Steps

81



@ Guickbooks.

Section 3 Objectives

Upon completion of Section 3 each participant will be familiar with the

following objectives:

* How to save and group custom reports.

* How to setup and review a Balance Sheet Statement.
» How to setup and review a Profit & Loss Statement.

* How to create a report and utilize Ask My Accountant.
* How to review an audit log.

* How financial reports are key to cash flow and profitability.
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Understanding Your Numbers

Customizing and viewing reports on a regular basis will ensure the accuracy of your
company data, and help you make better management decisions. Financial analysis
and reporting are the bedrocks of modern business, and the benefits are vast;
improved cash flow, debt and liabilities management, trend identification, real time
tracking, etc. Financial reports also help you remain in compliance with various

regulations.

The Custom Reports section allows you to save custom reports in groups and

streamline the time it takes to review reports daily, weekly, monthly, etc.

Once you understand what the numbers mean in your reports and where the data is
coming from, it will become obvious why creating unnecessary account categories
leads to costly cleanup. The various reports clarify what is going on in each area of
our business. Invest time to familiarize yourself with key reports that apply to your
business. If you are unsure what reports to track, talk to your instructor/advisor or
accountant for advice. Keep in mind you can customize and create detailed and

summarized reports as you learn more.

All business owners should focus on three main financial reports:
» Balance Sheet
» Profit & Loss

+ Statement of Cash Flows

Other important reports include:
* Ask My Accountant
* Audit Log
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Balance Sheet
The Balance Sheet provides information about the assets the business owns. There are

several types of assets including current assets, cash in the bank and money owed by
customers. Fixed assets are tangible items purchased, such as a vehicle or equipment
used to produce money. Fixed assets are depreciated over time and are typical items that
cost more than $2,500. Other assets include leasehold improvements, purchase of a

business, security deposits, etc.

Now let’s discuss liabilities, what the business owes. Short-term liabilities are paid within a
year and include sales and payroll taxes, garnishments, lines of credit, credit cards etc.
Long-term liabilities take more than a year to pay back and include vehicle or equipment

loans, SBA or building loans etc.

Finally, the equity section tells us how much your business is worth, tracking all profits and

losses from the time you start the business to the present. This section tracks all the

stock, owner distributions and contributions over the years. All information is rolled into

retained earnings, owner's equity, or member equity depending on the type of entity.

1. Click Reports in the left navigation bar -> select the standard tab -> scroll to
business overview -> Balance Sheet.

2. Click the star to save the report as a favorite or

3. Click reports in the left navigation bar and use the search feature. Select the

Balance Sheet. = == Bueme Oue Q0 8 O
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Balance Sheet

Balance Sheet
There are several ways to filter the data for your custom reports. Change the
Report period, Display columns, Show non-zero or active only, Accounting

method, and Compare Report periods.

Balance Sheet Report

£ Beck to report list

Report period 4 . N . .
- | Customize |EEETVERRIGIGIFETG]
This Year-to-date v 01/01/2023 to 01/12/2023
Display columns by Show non-zaro or active only Compare another pariod Accounting method )
[ Runreport |
Total Only v Non-zero Rows/active colur ¥ Select period A Cash @ Accrua g /
~

The Collapse option consolidates all sub-account balances within the main account.
The Expand option displays all sub-account balances. Sort by ascending or
descending order and Add notes. Click the appropriate icon to Email, Print or

Export a report.

Collapse Sortw Add notes Edit titles =2 S BT o

1. Click Customize to change the date range, accounting method and negative

numbers display.
Customize report

* Genera
Report period

Custom v 01/01/2023 to 01/12/2023

Accounting method
Cash @ Accrual

Number format Megative numbers

[ | Divide by 1000

|_| Without cents -
— | | Show in red

[

|7| Except zero amount
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Balance Sheet

2. Click Rows/Columns to change the way columns are displayed, Show non-zero rows
and columns, or add percentage of rows and columns.
3. Click Filter to select specific Customers, Vendors, or Product/Service items to be

displayed.

w Rows/Columns

Columns Show non-zero or active only
w Filter
Total Only - Mon-zero Rows/Mon ¥
[ | Customer Al -
Select and reorder columns o
[] % of Row L] Vendor A M
[ ] % of Column -
[ | Product/Service Al -

4. Click Header/Footer to add your logo, change the Report title, remove information

displayed, and change the alignment of the report. Click Run Report.

w* Header/Footer

Header

|:‘ Show logo

|z‘ Company name Craig's Design and Landscapir
|Z‘ Report title Balance Sheet

|7‘ Report period
Footer

|z‘ Date prepared
|7‘ Time prepared

|7‘ Report basis {cash vs. accrual)

Alignment
Header Center v
Footer Center w

86 QuickBooks Online Foundations



@ Guickbooks.

Balance Sheet

5. Click save customization.

6. Name your custom report or use the default name, add this report to a group, or
share it with a coworker. Organizing your reports in groups will save time locating
and reviewing your favorite reports.

7. Click Save.

Custom report name

Balance Sheet

Add this repert to a group

New group name

Financial Reports Add

Share with

|:| Share reports with community

* You share only your customized report structure anc

not your financia

Save

8. Now simply click on Reports -> Custom reports to quickly access your

customized Balance Sheet.

Reports

Standard Custom reports Management reports

NAME CREATED DATE RANGE EMAIL ACTION
Financial Reports Unscheduled Edit W
Balance Sheet Craig Carlson 01/01/2022-03/31/2022 Edit v
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Balance Sheet

This sample displays the assets portion of the Balance Sheet. In order to rely on

your financial data, it is important to verify that all asset account balances are

accurate.
Craig's Design and Landscaping Services
Balance Sheet
As of January 12, 2023
TOTAL
~ ASSETS
= Current Azsets
~ Bank Accounts
Checking ,201.00
Savings 800.00
Total Bank Accounts $2,001.00
~ Accounts Receivable
Accounts Receivable (A/R) 5,281.52
Total Accounts Receivable $5,281.52
w» Other Current Assets
nventory Asset Q625
Undeposited Funds 2,062.52
Total Other Current Assats $2,658.77
Total Current Assets $9,941.29
= Fixed Assets
-+ Truck
Original Cost 13,495.00
Total Truck 13,495.00
Total Fixed Assets $13,495.00
TOTAL ASSETS $23,436.29
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Balance Sheet

This sample displays the liability and equity sections of a Balance Sheet. In order to

rely on your financial data, it is important to verify that all liability and equity account

balances are accurate.

= LIABILITIES AND EQUITY
~ Ligbilities
+ Current Lisbilities
+ Accounts Paysble
Accounts Payable (A/F)
Total Accounts Payable
+ Credit Cards
Mastercard
Total Credit Cards
+ Other Current Lisbilities
Arizons Dept. of Revenue Payable
Board of Equalization Paysble
Loan Payable
Total Other Current Liabilities
Total Current Liabilities
+ Long-Term Liabilities
Motes Payable
Total Long-Term Liabilities
Total Liabilities
+ Equity
Cpening Balance Equity
Retasined Earnings
Net Income
Total Equity

TOTAL LIABILITIES AND EQUITY

1,602.67

$1,602.67

$4,370.94

$6,131.33

25,000.00
$25,000.00

$31,131.33

-9,337.50
1.676.46
-34.00
§-7,695.04

$23,436.29
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Profit & Loss
Profit & Loss
The Profit & Loss Report is an accumulation of income and expenses for a period.
At the end of each year the net profit or loss rolls into the equity section of the
Balance Sheet. Each new year starts with a zero balance for income and

expenses.

The profit & loss continues with the story about the health of our business. Are we
meeting our sales growth targets? When we subtract expenses directly related to
revenue, we can determine our gross profit margin. Do we have enough gross
profit to pay all other costs? When we subtract all other expenses from gross profit,
we can determine net income before tax and whether we are profitable. Each

category is a percentage of Income which we use as a cash management tool.
1. Click reports in the left navigation bar -> reports -> standard.
2. Scroll to business overview.

3. Click Profit and Loss % of Total Income or use the search feature.

Reports

Profit and Loss v

Profit and Loss Comparison
Standard  Customreports  Management reports

Profit and Loss by Tag Group

Profit and Loss as % of total income ¥

Favorites
Profit and Lo

Profit and Loss by Month

Balance Sheet : Profit and Loss Detail

Profit and Loss year-to-date comparison

Business overview

AuditLog
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Profit & Loss

4. Click Customize.

5. Change the Negative numbers to display with parenthesis and check the box

Show in red.

Just like the Balance Sheet, you can add rows and columns, filter information, or

change Header/Footer options.

Customize report
w General
Report period

Custom v

Accounting method
Cash @ Accrual

Number format
[ | Divide by 1000

[ ] without cents

@ Except zero amount

w Rows/Columns

Columns

Total Only

Change columns

¥ Filter

b Header/Footer

01/01/2022 to 03/31/

P
=]
Fa
P

Negative numbers

(100)

Show in red

-

Show non-zero or active only

- Mon-zero Rows/Non  *

Note: It is important to choose the same date range and accounting method used to

customize the Balance Sheet.
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Profit & Loss

6. Use the collapse/expand feature to hide or unhide subaccounts when

customizing reports.

Craig's Design and Landscaping Services

Profit and Loes % of Total Income
- December, 2022

TOTAL
OCT-DEC, 2022 % OF INCOME
b Income $9,809.52 100.00 %
p Cost of Goods Sold $405.00 413 %
GROSS PROFIT $9,404.52 95.87 %
= Expenses
Advertising 74.86 0.76 %
= Automobile 79.96 0.82%
Fuel 34941 356%
Total Automobile 429.37 4.38%
Equipment Rents 112.00 114 %
Insurance 241.23 246%
= Job Expenses 155.07 158 %
» Job Materials 802.82 8.18%
Total Job Expenses 957.89 .76 %
» Legal & Professional Fees 870.00 8.87 %
» Maintenance and Repair 940.00 9.58 %
Meals and Entertsinment 28.49 0.29%
Office Expenses 18.08 0.18%
Rent or Lease 200.00 917 %
b Utilities 331.39 3.38%
Total Expenses $4,903.31 49.99 %
MET OPERATING INCOME $4,501.21 45.89 %
= Other Expenses
Miscellansous 22814.00 2873 %
Total Other Expenses $2,916.00 29.73 %
MET OTHER INCOME $-2,916.00 -29.73 %
MET INCOME $1,585.11 16.16 %

Note: Remember to click save Customization and add this report to your new

report group in custom reports.
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Cash Flow

Business Tip: Cash flow includes all transactions that go in and out of your
bank accounts. Some transactions will post to the Balance Sheet, and some will
post to the profit & loss.

Cash flow is
generated by the
business cycle.

Marketing

E:s:;zz;' I he Business Think of the
) Cycle cycle as a
clock.

Marketing

Overhead

Any event that slows down
the clock, interrupts the
process, hurts cash flow.

Expenses

Invoicing

Staff
Adds

Value
Marketing
CEJve"head The proper use of
Xpenses . -
' QuickBooks will
significantly increase

Collecti . .
of il eu efficiencies and the

speed of the business
cycle.
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Ask My Accountant

This report can be a very helpful tool. It is used to post transactions when the user is
not sure which category to use. The memo field allows the user to post notes and
questions for their accountant. It can be a great way to train a new bookkeeper or
business owner.

1. Click on accounting in the left navigation bar -> chart of accounts tab.

2. Locate Ask My Accountant in other expense type, then click run report.

Ask My Accountant Other Expense Other Miscellaneous... Run report

3. Click customize -> header/footer to change the header to Ask My Accountant.
4. Change the Report Period to All Dates then click Run report.
5. Save Customization to save your report in custom reports.

Notice the Accountant’s response in the Memo/Description field to post the

transaction to Fixed Assets/Computer Equipment.

Craig's Design and Landscaping Services

Account QuickReport
Since October 18,2022

DATE TRANSACTION TYPE NUM NAME MEMO/DESCRIPTION ACCOUNT , CLR AMOUNT BALANCE

~ Ask My Accountant *
12/19/2022 Expense SQUEAKY KLEEN CAR WASH Ask My Accountant 1999 19.99
12/24/2022 Expense A1 RENTAL Ask My Accountant -800.00 -819.99

Total for Ask My Accountant $-819.99

TOTAL $-819.99 -

Note: It is important to clear up all transactions on this report before year end and
especially before filing a tax return. This is a placeholder for transactions that need

more information to post in the correct account or category.
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Audit Log

The Audit Log Report is a good way to view activity by user. This is a great training tool
used to enforce accurate data entry. The audit log is also a way to detect fraudulent activity.
1. Click reports -> search audit log.

2. Click the Filter button to search historical transactions by User, Date, or Events.

This month  Clear filter / View A

User

Date From To
Custom v

Events

@ Show all events

Show only these events

|_|S'gn in/sign out [ |Lists

[ ]Budgets [ | Time events

|_| Recurring templates |_| Statements
|_|Sett'"gs |_|Sa|es customizations

-0
i
8]
=]
=
o
w
=,
o
]
)
w
=%
o
]
¢
5]
w
=
1]
@

| Transactions

Show: | All Transactions ¥

Reset

Notice the filter criteria is set for a specific user and the historical data indicates when he

logged in and out, as well as specific transactions that were edited by Craig Carlson.
3. Click the gear icon to select columns to view.

4. Click view to see details for a specific transaction.

Jan 12,2023, 1:51 pm ... Craig Carlsen Signed Out.

Jan 12,2023, 1:4% pm ... Craig Carlson Edited Product or Service Design:Services Wiew
Jan 12,2023, 1:4% pm ... Craig Carlson Edited Product or Service Design:Lighting View
Jan 12,2023, 1:4%9 pm ... Craig Carlson Edited Product or Service Design:Rocks WView
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Section 3

All business owners should complete this section and apply the knowledge to their
own company file. Remember! You can always refer to various Modules of training if

you need additional reminders of how features works.

1. Watch Video Links:
Understanding the Balance Sheet in QuickBooks Online (2:34)

Understanding Profit & Loss Statement: Income, Cost of Goods (1:54)

How to use the Audit Log in QuickBooks Online (2:02)

2. Create, save and review the following reports:
+ Balance Sheet
» Profit & Loss with Percentages
+ Statement of Cash Flows

» Ask My Accountant
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Online Foundations Training

SECTION 4
ACCOUNTS RECEIVABLE

Goals

Customer Center
Sales Receipts

Bank Deposits
Invoices

Receive Payments
QuickBooks Payments
Action Steps
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Section 4 Goals

Upon completion of Section 4 each participant will be familiar with:

* An overview of accounts receivable.

* How to correctly use customer and accounts receivable-related accounts and settings.
* How to use the Customer Center.

* How and when to use a sales receipt versus an invoice.

* How to receive payments and record deposits.
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More About Accounts Receivable

In the accounts receivable section, we discuss the importance of managing open invoices,
money owed to you by customers. You might be surprised by how costly this process can be

if an efficient system is not in place. The affect on cash flow can be profound.

Wow!
According to the Harvard Business Review, here is an average of what receivables cost a
company. This does not include the probability of collection, which falls drastically the

further out an unpaid bill is allowed to go.

30 days — 1.82%

60 days — 9.20%
90 days — 17.74%
120 days — 26.71%

Did you know?
By reducing average time to payment by just one day, a typical company with an average
15-18% receivable doing:
* 250K in annual sales, would add $700 per one day decrease in average time to
payment to their cash flow.
* 500K in annual sales, would add $1,400 per one day decrease in average time to
payment to their cash flow.
* 1M in annual sales, would add $2,800 per one day decrease in average time to

payment to their cash flow.
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Customer Center

The Customer Center includes options for maintaining customer lists, adding invoices,

receiving payments, and viewing transactions related to your customers.

1. From the left navigation bar click invoicing -> customers to access the Customer Center.
2. Click the invoices tab to view and manage invoices.
3. Click the drop-down arrow to select from a list of options, such as send reminders,

create statements, invoices, sales receipts, and estimates.

Customers =D

Unbilled Last 365 Days Unpaid Last 365 Days Paid

$0 $750 $1,526 $3,136
0 ESTIMATE 3 UNBILLED ACTIVITY 10 OVERDUE 12 PAID LAST 30 DAYS

I Batch actions v &y ’

[ ] cusTOMER «/ cOmMPANY PHONE OPEN BALANCE ACTION
Amy's Bird Sanct

I:I .my s_, " - ancuary [ (650) 555-3311 $239.00 Receive payment v
Bill's Windsurf Sh

[ B WindsuriShop ] (415) 4446538 535.00 Receive payment v

4. Use Batch actions to create statements or email several invoices at one time. The search

field is a quick way to find a customer.

Batch actions « Columns

Creete statements ( |:| Customer Type
Emall b |:| Attachments
Make inactive o
. . . . |./| Address
5. Click the Gear icon to edit the way columns are displayec c-corerses 7
one
[] Email

Note: You can manage sales, products and services and e

|:| Include inactive

more, from the Sales Center. [ Include projects
Rows

150 «
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Add Customer

Customer Center

1. From the Customer Center click new customer.

2. Enter customer and display name (the way you would like the name displayed in the

Customer list).

3. Add contact information.

Customer
f3] Name and contact ™~
Title First name Middle name Last name Suffix
‘ ‘ | Amy ‘ | | ‘ Lauterbach | | ‘
Company name Customer display name *
‘ Amy's Bird Sanctuary ‘ | Amy's Bird Sanctuary v ‘

Email

FPhene number

‘ Birds@Intuit.com

‘ | (650) 555-3311 ‘

Maobile number

Fax

Other

Website

MName to print on checks

‘ Amy's Bird Sanctuary

\:' Is a sub-customer
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Customer Center

4. Next, add Address information. You can click the Map link for directions to this customer

location.

© Addresses ~

Billing address

Street address 1 Street address 2

| 4581 Finch St. |

City State

| Bayshore | CA ‘
ZIP code Country

| 94326 | | ‘

Shipping address

Same as billing address

5. Use the Notes and Attachments features to keep important information or agreements
for this customer. This information is for internal purposes and will not be seen by the

customer.

6. The Attachments tab allows you to drag and drop attachments specific to a Customer.

[£] Notes and attachments ~

Notes

Attachments

Add attachment

Max file size: 20 ME
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Customer Center

The Additional info tab is where you can assign a Customer type to track specific

information.

7. Click Customer type from the Customer Center.

8. Manage Default sales tax codes for this customer and add beginning balances.

) Additional info ~

Customer type

Taxes

Exemption details
This customer is taxable

Default tax code

| California (8%) W

Opening balance (3)
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Customer Center

Once you click on a customer from the list you have the option to filter by name or details.
1. Sort by name or open balance.
2. Collapse the list by clicking the bar/arrow icon.

3. Click the symbol to add a new customer.

€ Customers + Se

( Sort by name a )

Amy's Bird Sanctuary
$239.00

Bill's Windsurf Shop
$85.00

Cool Cars
$0.00

4. Each customer has a Transaction List and a Customer Details tab where you can view
transaction history and customer information.

5. Track Late Fees per customer or send transactions and reminders using the Batch
Actions options.

6. You can print, export to Excel, or use the gear icon to change the way the information is

displayed on the screen.

Transaction List Customer Details Late Fees
( Batch actions v ) ( Filter = )‘
1-9 of 9
|7| DATE = TYPE NOQ. MEMO DUE DATE BALANCE TOTAL STATUS ACTION
[] 127162022 Payment 12/16/2022 $0.00 -$220.00  Closed

| | 12/15/2022 | Payment 6552 12/15/2022 50.00 -3108.00 | Closed
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Customer Center

Edit Customer
1. Click on the customer in the Customer Center that you wish to edit.

2. Click the Edit button to open the customer information window.

! o P R
Amy s Bird Sanc‘cuary B8 ¢ ( Edit h ) New transaction v
Amy's Bird Sanctuary 4581 Finch St., Bayshore, CA 94326 - Edit menu
. Make inactive $239.00
Add notes OPEN

Merge contacts $239-Q0

Make Inactive
Select from the action column in the Customer Center to

make a customer inactive.

Merge Customers
Go to the customer (merge transactions from) you want to merge.
Click the drop-down menu to the right of edit, then click merge contacts.

Select the customer you want to keep (into).

A w N

Keep in mind the information for the “from” customer will be deleted and the customer
will be inactivated.

5. Click Merge contacts.

Amy's Bird Sanctuary 4581 Finch St., Bayshore, CA 94326
Make inactive %_2_3900

cly OVERDUE

Add notes
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Sales Receipts

A sales receipt is used when a customer pays you on the spot for goods or services and you

need to record the sale after the fact.

Click the +New icon -> Sales Receipt under the Customer menu.

It is important to understand the difference between the sales receipt and invoice process.
Processing a Sales Receipt requires two steps.
1. Create sales receipt using undeposited funds for the deposit to category.

2. Bank deposit.

(£ Sales Receipt & () Help
Customer / Email Cc/Bee AMOUNT
Oylon Salfrak . $337.50

[ ] send Iate:

Billing address Sales Receipt date [

Dylen Sollfrank 01/12/2023

Tags () Manage tags

Payment method Reference no. Deposit to ’

Undeposited funds is a holding account that allows you to receive sales receipts or
payments against invoices. This allows you to group payments from multiple customers into

one deposit in order to match the deposit sent to the bank.
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Sales Receipts

The middle section of a sales receipt requires the items we are selling. This is where your

Products and Services or Items list comes into play. This allows us to track sales by item to

determine our top selling product or service.

The last section of a sales receipt records sales tax, discounts and tips. You can switch the

order of the sales tax and discounts, so the discount is taken prior to the sales tax

calculation.
# PRODUCT/SERVICE DESCRIPTION
1 Design:Design Custom Design
2

Addlines | | Clearalllines

Message displayed on sales receipt

Thank you for your businsss and have a great day!

aTy RATE AMOUNT TAX

45 75 337.50

‘ Subtotal $337.50

Taxable subtotal $0.00
Need help with sales tax? Learn more

Discount percent ¥ $0.00
Message displayed on statement Total $337.50
Amount received $337.50
Balance due 50.00
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Bank Deposits

Creating bank deposits is a very important step that follows the sales receipt or receive
payment process and is often overlooked. This can lead to a compounding issue with

undeposited funds and can be costly to clean up.

Click the +New icon -> Bank Deposit.

It is very important to select the correct bank account for each deposit. Some businesses
have multiple accounts. Make sure that the total amount of selected individual payments
in undeposited funds matches the total amount deposited at the bank. Checks and cash
might be grouped together, whereas credit card payments are deposited based on the
batch transferred to the bank. For this example, we deposited online customer sales for

both locations.

49 Bank Deposit @Help

AMOUNT
Account Date

Checking v | Balance $1,201.00 01/12/2023 $2,062 -52

Select the payments included in this deposit
[L]  RECEIVED FROM « DATE TYPE PAYMENT METHOD MEMO REF NO. AMOUNT
E\ Cool Cars 12/17/2022 Payment - 1,675.52

12/17/2022 Payment A 387.00

| Selectall | | Clearall | Total 2062.52

Selected Payments Total 2062.52
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Invoices

An invoice is used when a customer agrees to pay you later. Terms are set up to determine
how long the customer has before payment is due. If they do not pay within a specified

time, the invoice is considered overdue.

An invoice requires three-steps:
1. Createinvoice.
2. Receive payment to undeposited funds.

3. Bank Deposit. Click the +New icon -> Invoice.

Enter the following information:
Customer name, email, invoice date, terms, invoice date and verify the location

information.

& Invoice #1001 D Takeatour  § (@ Help

PAYMENT STATUS
Customer () / Customer email (3 CofBec
Amy's Bird Sanctuary] v Birds@Intuit.com PA | D

[] sendleter @
1 payment mace ($108.00)

Billing address Terms () / Invoice date / Due date l

Amy Lauterbach Net 30 - 12/18/2022 01/17/2023

Amy's Bird Sanctuary

4581 Finch St. Creste recurring invoice

Bayshore, CA 94326
Tags () Manage tags

Many business owners end up with duplicate transactions and unnecessary cleanup when
they do not complete the steps in the proper order, or when they post payments directly to

the bank account instead of undeposited funds.
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Invoices

The next section of an invoice is all about the products or services you are selling the
customer. In this example, we used the catering service bundle to collect the up-front

setup, equipment rental and delivery fee.

The last section of a sales receipt records sales tax, discounts and tips. You can switch the

order of the sales tax and discounts, so the discount is taken prior to the sales tax

calculation.
# PRODUCT/SERVICE (7) DESCRIPTION ary RATE AMOUNT  TAX
1 : Landscaping:Gardening Weekly Gardening Service 4 25 100.00 v
2
Addlines | | Clearalllines | | Add subtotal Subtotal $100.00

Message on invoice

Thank you for your business and have a great day!

Discount percent $0.00
d Taxable subtotal
Need help with sales tax? Learn more
California v 8% 8.00
Message on statement Total $108.00
Front yard, hedges, and sidewalks
Amount received $108.00
Balance due $0.00
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Receive Payments

Receiving full or partial payments against open invoices is part of the account’s receivable
management process. Having accurate customer balances is key to avoiding messy cleanup

and cash flow issues.

Note: Always apply the amount received to the appropriate invoice. This will ensure that
the Invoice is closed out properly. If a partial payment is received, then a balance will

remain on your Accounts Receivable Aging report for that customer.

If you use Square or PayPal, merchant fees are deducted for each transaction. Other
merchant services will deduct their fees at the end of the month. Not to worry! Merchant

fees will be addressed in the bank deposit process.

Undeposited funds is simply an asset account that acts like a clearing account. When
payments are posted to undeposited funds, they sit in this account until a deposit is made

to offset the balance.

When a payment is received, undeposited funds is debited, and accounts receivable is
credited. When a deposit is made, the bank account is debited, and undeposited funds is

credited. Undeposited funds should ultimately have a zero balance.

Select undeposited funds for the deposit to box.

This will allow you to group cash, checks, and credit card payments to match the deposit
sent to the bank. It is very important to match deposits in QuickBooks to the deposits

posted at your bank. This will help to create a more efficient reconciliation process.
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Receive Payments

1. Click the +New icon -> Receive Payment.
2. Enter the following information:

Customer name, date, method, reference, and deposit account.
3. Select invoices and verify the total received.

Verify the invoices selected; match the payment stub or backup.
4. Notice the Find by invoice no. and Filter feature.

5. Click Save and Close or Save and New.

(%) Receive Payment @ Help
Customar AMOUNT RECEIVED

Amy's Bird Ssnctuary ~ | Find by invoice no. ‘ $ 23 9 .00

Payment date

Payment method Referance no. Deposit to Amount received

v 6552 Undeposited Funds ~ 239.00

Qutstanding Transactions

| Filter > A
DESCRIPTION DUE DATE ORIGINAL AMOUNT OPEN BALANCE \ PAYMENT
Invoice # 1021 (11/29/2022) 12/29/2022 45%.00 239.00 232.00
f 1-10f1
Amount to Apply £239.00

Amount to Credit $0.00

| Clear Payment ‘
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QuickBooks Payments

There are several options to help receive payments faster through automation.

QuickBooks Payments is one of those options and is designed to speed up the accounts

receivable cycle and improve cash flow.

The payment systems allows customers to pay directly from an invoice by credit card, debit

card, ACH or eCheck, by clicking a link embedded in the invoice. No more waiting on a

check in the mail.

QuickBooks Payments also allows you to get paid on the go by accepting debit or credit

cards on your phone. In addition, QuickBooks Payments makes it easy to set recurring

invoices to be automatically sent and paid.

QuickBooks Payments

Pay-enabled invoices

Accept credit card payments and debit cards

online.

Learn about invoicing

Schedule in advance

Set recurring invoices to be automatically sent

and paid.

Learn about invoicing

Get paid on the go

Take contactless, in-person payments from

anywhere.

Learn about mobile payments

Fast deposits

Access eligible payments next day, or

instantly for 1% more.**

Learn about deposits

Overview Features v m

ACH and eChecks

|3

Let customers pay digitally, instead of by mail.

Learn about e-payments

Automatic bookkeeping

We'll match payments for you, however

customers pay.
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Module 2 Doable Action Steps

If you do not need to use the accounts receivable features, skip this section. Otherwise

follow the steps.

1. Review video links:

How to Add, Edit & Manage Your Customers List (3:07)

Invoices vs sales receipts: which to use when (1:29)

How to Record a Sales Receipt (2:32)

How to Send Estimates, Quotes, & Proposals (2:16)

How to Convert an Estimate Into an Invoice (2:06)

How to create a customer invoice (4:29)

How to Create an Invoice: Billable Time & Expenses (3:45)

How to Record an Invoice Payment (using Undeposited Funds) (2:27)

How to record a bank deposit (using undeposited funds) (2:21)

How to Track What Customers Owe You: Accounts Receivables & More (2:37)

How to Record Customer Credit: Credit Memos & Balances (2:45)

How to Refund Customers: Refund Receipts (3:22)
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Online Foundations Training

SECTION 5
ACCOUNTS PAYABLE

Goals

Vendor Center
Contractors
1099s
Expenses
Checks

Bills

Pay Bills
Action Steps
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Section 4 Goals

Upon completion of Section 4 each participant will be familiar with:

* Overview of accounts payable.

* How to turn on/off accounts payable-related accounts and settings.
* How to manage the Vendor Center.

* How to track contractor information.

* How to create checks and expenses.

* How to create credit card expenses.

* How and when to create and pay bills.
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More about Accounts Payable

In the accounts payable section, we will discuss the importance of implementing an
accounts payable policy, establishing internal controls to prevent payment fraud and
managing your bill payment process to take advantage of discounts offered by vendors. This
process has a significant impact on cash flow. Consistently implementing a best practice’

accounts payable policy is far more important than most business owners realize.

Wow!

According to JPMorgan, 78% of U.S. businesses were exposed to attempted or actual
payments fraud in 2019; however, due to increased awareness, improved training and more
vigilant best practices, only 48% of exposed businesses experienced a case of fraud costing

$250,000 or more.

While fraud is a huge problem for small business owners, many do not understand how
costly it is to process an invoice. In their benchmark study, Aberdeen Group found that the
industry average cost to process an invoice was $15.61. “Laggard” companies (bottom 30%)
had an even larger average cost of $38.77, while “Best-in-Class” companies (top 20%) had

an average cost of just $3.09.

For the above reasons and more, implementation of a best practice accounts payable policy

will be an integral part of your success!
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Vendor Center

1. Click Expenses -> Vendors in the left navigation bar to access the Vendor Center.

Here, we will view open and overdue bills, maintain vendor information, and view historical
transactions. Use the search bar to find a vendor or company. You can email vendors directly by

clicking the drop-down arrow for Batch actions. You can click Prepare 1099s and complete the

step-by-step wizard.

Vendors

P -
* | Prepare 1099s |+ |
p. ~

Unbilled Last 365 Days Unpaid Last 365 Days Paid

1 PURCHASE ORDER 4 OVERDUE 21 PAID LAST 30 DAYS

* o A
Q

I
[] VENDOR a / COMPANY PHONE EMAIL OPEN BALANCE ACTION
D Bob's Burger Joint 50.00 Create bill W
[ BeoksbyBessie [ (650)555-7745 Books@lnuit.com 50.00 Createbill ¥
2. Click the drop-down arrow
el

in the action column to

o

ACTION

Create bill @

create bills, create Columns ’
\:l Addrass

expenses, write checks,
D Attachments

and more. i
Create expenss ‘ Phone
Write check Email
3. Click the gear icon to
Create purchass order Other

add and remove columns

displayed.

Make inactive

\:l Include inactive

Rows

130 =
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Vendor Center

Add Vendor

1. Click New Vendor

2. Enter the Company name and other details you have on file. The company name, vendor
display name and name to print on checks can be different. The display name can be

unique to manage your vendor list. The company name will appear on expense forms.

Vendor

{8] Name and contact ~
Company name Vendor display name *
‘ Rockin Landscape Materials | Rockin Landscape Materials v ‘
Title First name Middle name Last name Suffix
Email Phone number
‘ info@caltel.com | ‘ ‘
Maobile number Fax

Other Website

Name to print on checks

‘ Rockin Landscape Materials ‘
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Vendor Center

3. Next, add Address information.
You can click the Map link for directions to this vendor location. Use the Notes and
attachments feature to keep important information or agreements for this vendor. This

information is for internal purposes and will not be seen by the vendor.

© Address ~
Street address 1 Street address 2
City State

ZIP code Country

[£) Notes and attachments

Motes

Attachments

Add attachment

Viax file size: 20 MB
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Vendor Center

You can use the information provided by vendors who provide a service and complete a W9

form to enter the Business ID No.

4. 3. Check the Track payments for 1099 box for all vendors for which you are required to

file 1099s.

5. 4.The Expense rates field is a default rate you use to invoice customers for expenses

incurred while providing a service.

6. 5. Payment Terms auto-populate when you select a default term here.

7. 6. Add a vendor Account no. for reference purposes.

2y Additional info

Taxes

Business ID Mo. / Social Security No. l

‘ D Track payments for 1099

Expense rates

Billing rate (/hr)

Payments

Terms ’ Account no. ’

| v

8. Adding a Default expense category from your chart of accounts list here will help save

time as it auto-populates on expense forms. This is especially helpful when new users

are learning how to categorize transactions.

Accounting

Default expense ceteg-:y

Opening balance (7)

Opening balance As of

01/12/2023
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Vendor Center

9. Click on a Vendor from the list in the Vendor Center.
10. Use the bar/arrow to search by name or company.
11. Sort by name or open balance.

12. Collapse the list by clicking the bar/arrow icon.

13. Click the symbol icon to add a new vendor.

Expenses Vendors

€ Vendors

mni
-

Q

G ON

Bob's Burger Joint
$0.00

Books by Bassie
$0.00

14. Each vendor has Transaction List and Vendor Details tabs containing transaction history and

vendor information, respectively. You can choose to print or export transaction history to Excel.

ansaction List Vendor Details

( Batch actions v ) ( Filter = )

|_| DATE = TYPE NO. PAYEE CATEGORY MEMO
|7| 12/15/2022 | Bill Payment (Ch... 3 Books by Bessie
[] 1203r2022 il Books by Bessie Legal &Pro | v

15. Select™ —
transactions.
16. Click the drop-down arrow for Filter to sort by Type and Date.

17. Click the gear to select columns to display.

TOTAL ACTION

-$75.00 View/Edit

$75.00 View/Edit

Note: Display options change as you turn on/off features in account and settings.

( Batch actions v )
Type
|i| ‘ All transactions v
Categorize selected
___be Date
All dates A

Columns
[ I:l Method f

|:! Source

[ ] Due date
[] Batance

|:| Status

|:| Attachments

] [] Type
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Vendor Center

Edit Vendor
1. Click on the vendor in the Vendor Center that you wish to edit.

2. Click the Edit button to open the vendor information window.

=4 Sample Company 8 My Experts @ Help Q Q @ o
Expenses
Expenses Bills Vendeors
< Vendors z« CalTelephone ¢ o™ (Edit |~
S e
- Cal Telephone 10 Main St., Palo Alto, CA 94303
- Make inactive %QGO
Sort by name 4 Merge contacts I $0.00
OVERDUE

-

Books by Bessie
50.00

Make Inactive

ACTION

Select from the action column in the Vendor Center to -

make a vendor inactive or edit the vendor and click the Create expense
. Write check
Make Inactive button.

Create purchase order

Make inactive

Merge Vendors
Go to the vendor (merge transactions from) you want to merge. Click the drop-down menu to the
right of edit then click merge contacts. Select the vendor you want to keep. Keep in mind the

information for the “from” vendor will be deleted and the vendor will be inactivated. Click merge

contacts.
=« Sample Company B mepes @Hp Q O @ @
Expenses
Expenses Bills Vendors
< Vendors z« CalTelephone ¢ o™ (Edit [V
e g
- Cal Telephone 10 Main St., Palo Alto, CA 94303

Make inactive $:O:OO

Q
OVERDUE

a

Books by Bessie
$0.00
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Contractors

Add Contractor

It’s crunch time and we realize we are missing contractor information to process 1099s.

You can invite contractors via email. The contractor will be prompted to input the required

information.

1. Click Payroll in the left navigation bar.

2. Click Contractors -> Add a contractor.

3. Enter Name and Email to send contractor invite to complete their profile. This will setup
an account to safely share their personal information. Use the Contractor Center to
write a check, create an expense or bill, and prepare 1099s.

4. Click the vendor's name to view more details, payments and documents.

5. Click the down-arrow in the Active button to inactivate a vendor.

Add a contractor

Email this contractor to complete their profile. They'll get their own
account to safely share their personal details.

Preview

i
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1099s

Many business owners are unaware of their responsibility to file 1099 forms with the Internal
Revenue Service each year. If you pay an individual or business $600 or more for services
rendered, you are required to file form 1099-NEC. However, you are NOT required to file form
1099 for services rendered, when the entity is a Corporation. Form W-9 is used to determine
entity type and reporting information. It is important to supply and require recipients to fill
out form W-9. This will save you a lot of time tracking down information at the end of each

year.

If you pay rent for a building or space, you are required to file form 1099-Misc.
If you borrow money from an individual and pay interest, you are required to file form 1099-
Int.

If you pay via credit card, all payments are reported on a 1099-K form.

It is important to incorporate the following best practices in your business:
* Require all individuals or businesses providing services to complete a W-9 form.
* Do not pay for services rendered until you receive a signed W-9 form.
* Add a recurring event to complete 1099 filing before January 315t each year.
* Keep track of all 1099 recipients in QuickBooks Online all year.

Note: You can visit www.irs.gov to learn more about the various types of 1099 reporting.

The general rule is that you must issue a Form 1099-NEC to any vendors or sub-contractors
you have paid at least $600 in rents, services, prizes and awards, or other income payments in
the course of your trade/business in a given tax year (you do not need to issue 1099s for

payments made for personal purposes).
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1099s

W-9 Form

The W-9 Form requires the recipients name, address, entity type, Social Security number

or Employer Identification Number, signature and date.

o w.g Request for Taxpayer Give Form to the
{Rev. October 2018) Identification Number and Certification requester. Do not
Department of the Treasury send to the IRS.
Internal Revenue Senvice P Go to www.irs.gov/FormW3 for instructions and the latest information.

1 Mame (a5 shown on your incoms tax retum). Name is required on this line; do not leave this line blank.

2 Business name/disregarded entity name, if different from above

3 Check appropriate box for federal tax classification of the person whose name is entered on line 1. Check only one of the | 4 Exemptions (codes apply only to
following seven boxes. certain entities, not individuals; ses
instructions on page 3):

]

g

5 J Individual'sole proprietor or _I C Corporation _I 5 Corporation _l Partnership _I Trust/estate
F E single-member LLC Exempt payee code (if any)
s _| Limited liability company. Enter the tax classification (C=C corporation, S=5 corporation, P=Partnership) »
8 E Note: Check the appropriate box in the line above for the tax classification of the single-member owner. Do not check | Exemption from FATCA reporting
- .E LLC if the LLC is classified as a single-membser LLC that is disregarded from the owner unless the owner of the LLC is. £
‘E another LLC that is not disregarded from the owner for U.S. federal tax purposes. Othenwise, a single-member LLC that code (f any)
o % is disregarded from the owner should check the appropriate box for the tax classification of its owner.

[7] Other see instructions) » {Anpias io accounts mainisined utsida the LLS )
5§ Address (number, street, and apt. or suite no.) See instructions. Reguester's name and address (optional)

6 City, state, and ZIP code

T List account number(s) here (optional)

Taxpayer Identification Number (TIN)

Enter your TIN in the appropriate box. The TIN provided must match the name given on line 1 to avoid Social security number
backup withholding. For individuals, this is generally your soclal security number (SSN). However, for a

resident alien, sole propriator, or disregarded entity, see the instructions for Part |, later. For other - -
antities, it is your employer identification number (EIN). If you de not have a number, see How fo get a

TIN, later. or

Mote: If the account is in more than one name, see the instructions for line 1. Also see What Name and Employer identification number
Number To Give the Requestar for guidelines on whose number to anter.

Part Il Certification

Under penalties of perjury, | certify that:

1. The number shown on this form is my correct taxpayer identification number (or | am waiting for a number to be issued to me); and

2. 1 am not subject to backup withholding because: (a) | am exempt from backup withholding, or (b | have not been notified by the Intermal Revenue
Sarvice (IRS) that | am subject to backup withholding as a result of a fallure to report all interast or dividends, or (¢) the IRS has notified me that | am
no longer subject to backup withholding; and

3. 1am a U.S. citizen or other U.S. person (defined below); and

4. The FATCA code(s) entered on this form (if any) indicating that | am exempt from FATCA reporting is correct.

Certification instructions. You must cross out item 2 above If you have been notifled by the IRS that you are currently subject to backup withholding because

you have failed to report all interest and dividends on your tax return. For real estate transactions, item 2 does not apply. For mortgage interest paid,

acquisition or abandonment of secured property, cancellation of debt, contributions to an individual retirement arrangement (IRA), and generally, payments
ather than interest and dividends, you are not required to sign the certification, but you must provide your cormect TIN. See the instructions for Part |1, later.

Sig" Signature of
Here | us. person» Date »
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1099s

1. Go to the Vendor or Contractors Center, click Prepare 1099s -> Let’s get started.

2. Review your company information. -> Save.

Company

Review your company info

If anything isn't correct, change it now. We'll save it in your company settings.

N_E_!“E__?"]_E' a_ﬂd_[’_EEE_-_ Craig's Design and Landscaping Services
123 Sierra Way
San Pablo, CA 94806

Phone number 1-800-445-8348

Tax ID §9-9999999

Contractor services rendered are always Box 1 of form 1099-NEC. There can be multiple
categories per box. It all depends on the categories used when posting transactions related

to recipients. Rents are reported on Box 1 of 1099-MISC. Select all categories that apply.

3. Click Next.

Map your QuickBooks contractor payments to 1099 boxes

1. Furst select the checkbox for each type of contractor payment you recorded last year. Each payment type corresponds to a
box on the IRS forms 1099-NEC or 1099-MISC. (Non-employee compensation and rents are the two most commeon types.)
2_ Then for each pavment type selected, select all the QuickBooks expense accounts yvou used last vear. Need more help with

this page?

If you're not sure which expense accounts vou used. you can run a report of all last year’s expenses marked for 1099,

Common payment types \

Non-employee compensation (most common) Box 1 1085 NEC
Installation v

Rents Box 1 1055-MISC “
Rent or Lease v
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1099s

4. Review your contractor's info. Required information will appear in red. Edit the vendor
and add missing information. If you notice vendors missing from the list, click Add from
Vendor list.

5. Click Next or Save and finish later.

Review your contractors' info

Make sure your contractors' details are correct. To see which contractors meet the 1099 thresheld, click Next.

Need to add anyone? ‘
. | Add from Vendor list

CONTRACTOR NAME ADDRESS TAXID EMAIL ACTION

Nick Brosnshan P.C.Box 5 -
23-4569875 Add Er dit

Brosnahan Insurance Ager Middlefield CA 94482 23456587 =

1-1 of 1

6. Next, you will verify the totals. If the name still appears in red, add the missing
information to complete the process. Click Finish preparing 1099s or Save and finish

later.

7. The last step is to select one of the options that populates in the pop-up window. If you
select Automated E-File and Delivery, Intuit will process the forms. If you choose Print
& Mail, you will receive a kit in the mail and will be responsible for filing the forms.

Pricing will be listed under each option.
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Expenses

It is important to differentiate between checks and expenses. While many checks are
written for expenses, (not all checks), they are handled in a different manner than expenses
in QBO. This makes a difference when bank transactions attempt to find a match during the
sync process in the Banking Center. Expenses are typically debits/ACH and credit card-type

transactions.

To enter expenses manually:

1. Click the + New icon -> Expense.

2. Next, enter or verify the following information:
Vendor name, bank account, payment date, and reference number.

3. Enter the account, description, and amount, specify whether the expense is billable, and
assign the transaction to a customer or job.

4. Click Item details to enter the Product/Service you are tracking. This section is typically
used when tracking inventory-related products.

5. Click Save and New or Save and Close.

() Expense #76 B Tekeatour 08 (2) Help

& AMOUNT
Payea / Payment account () /
S $75.00

Pam Seitz ~ Checking ~ Balance $1,201.00
Paymant date 1 Payment methad Ref no.
01/12/2023 - 76

Tags (2) Manage tags

v Category details ‘

# CATEGORY () / DESCRIPTION AMOUNT  BILLABLE (%) TAX CUSTOMER (%)
1 Legsl & Professionsl Fees Counssl 75.00

2

| Addlines | | Clearalllines |

» ltem details
Total §75.00
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Checks

Here is where we enter checks written manually or checks to be printed. Be sure to include
the check number in the reference number field. Also, select Check instead of Expense.
This makes a difference when bank transactions attempt to find a match during the sync
process in the Banking Center.
1. Click the +New icon -> Check.
2. Next, enter or verify the following information:
Payee name, bank account, payment date, and check no.
3. Enter the account, description, and amount, specify whether the check is billable, and
assign the transaction to a customer or job.
4. Click Item Details to enter the Product/Service you are tracking. This section is typically
used when tracking inventory and non-inventory related products.

5. Click Save and New or Save and Close.

=
(& Check #71 @ @ Help
Payos / R / AMOUNT
Hicks Hardware v Checking v Balance $1,201.00 $228075
Mailing address Payment date Check no.
Geoff Hicks 01/12/2023 71
Hicks Hardware

42 Mein 5t o
Middiefield, CA 54303 [ |Print later

Tags (7) Manage tags

» Category details

v ltem details /

# PRODUCT/SERVICE DESCRIPTION Qary RATE AMOUNT BILLABLE TAX  CUSTOMER
1 | Design:Fountains:Rock Fountain: Rock Fountain 1 125 125.00
2 . Landscaping:Sprinklers:Sprinklet Sprinkler Heads 15 0.75 1125
3 | Landscsping:Sprinklers:Sprinklei Sprinkler Pipes 25 2.50 62.50
4 Design:Fountains:Pump Fountain Pump 3 10 30.00
5
| Addlines | | Clearalllines | Total $228.75
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Bills

Bills are an important part of accounts payable. We enter bills to be paid later. Use reports

to monitor due dates and budget for next bill pay day.

1. Click the +New icon -> Bill.

2. Next, enter or verify the following information:

Vendor name, mailing address, terms, bill date, due date, and bill no.

3. Enter the account and amount, specify whether the bill is billable, apply sales tax, and

assign the transaction to a customer or job.

4. Click Item details to enter the Product/Service you are tracking. This section is typically

used when tracking inventory-related products.

5. Click Save and New or Save and Close.

& Bill

Vendor 1

Robertson & Associates ~

Mailing address Terms

Bill date /

01/12/2023

Jenny Robernison Net 30 =
Roberson & Associates

P.O.Box 147

Bayshore, CA 94326

Tags (7)

v Category details ﬁ

# CATEGORY DESCRIPTION

1 Legsl & Professional Fees: Accounting

2

[ Addlines | [ Clearalilines |

» ltem details h

& @ Hop
BALANCE DUE
$315.00
Due date [ Bill no. ’
02/11/2023
Manage tags
AMOUNT BILLABLE TAX CUSTOMER
315.00
Total $315.00
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To Pay Bills

Pay Bills

1. Click the +New icon -> Pay Bills -> Select the Payment account -> Select the Payment

date.

2. Select the bills you want to pay. If you need to make a partial payment, simply change

the amount in the Payment column.

3. Click the drop-down arrow to change the filter criteria or click the gear icon to change

the number of rows being displayed.

(% Pay Bills

Payment account /

Mastercard

‘: Filter > ‘ Last 365 Days

L]
[v]
[v]
[v]

v

¥

PAYEE

PG&E

Norton Lumber and B

Robenson & Associates

Brosnahan Insurance

Diego's Road Warrior .

5 bills selected

~

REF NO.

Payment date /
Balance $157.72 o

)1/12/2023

DUE DATE «

12/02/2022

12/17/2022

12/17/2022

12/20/2022

01/14/2023

@ Hep X

TOTAL PAYMENT AMOUNT

$1,602.67

\ 5 open bills, 4 overdue 4
CREDIT APPLIED

OPEN BALANCE PAYMENT TOTALAMOUNT
o $86.44 Nor available 86.44 5$86.44
o $205.00 Nor available 205.00 $205.00
o $315.00 Nor available 315.00 $315.00
o $241.23 Nor available 24123 $241.23
$755.00 Nor available 755.00 $755.00
§1,602.67 $0.00 $1,602.67 $1,602.67
Total payment (USD) 1,602.67 1 5efs
Current account balance $157.72
ﬁ Total payment $1,602.67
New account balance $1,760.39

4. If you are paying with a handwritten check, uncheck Print later and click Pay Bills. If you

are printing a check, select Print later.

5. Click Save and Print or Save and Close. After you select Save and Print, the Print Checks

Setup window will appear. Simply follow the steps.
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Bill Pay for QuickBooks Online

The bill pay feature in QuickBooks Online is designed to streamline your payment process,
thus sending more to the bottom line. Systemizing accounts payable can reduce costs

significantly and drastically reduce the time it takes to manage the process.

Key benefits:

* Track payment status such as estimated delivery times and remittance
information. Paying by check? Receive visual proof once it's been deposited.

* Pay your vendors and contractors, international and domestic, with the same
process. Pay one bill at a time, or several at once. Enter payment amount, choose
your process date, and click submit - that's it.

* Bills and invoices sync automatically with QuickBooks Online, reducing double

data entry and speeding up account reconciliation.

How it works with QuickBooks
Bill pay integrates with QuickBooks Online Essentials, Plus, and Advanced, so you can pay,

track, and manage bills right inside the software.

Review video link:

Bill Pay for QuickBooks Online (2:30)

133 QuickBooks Online Foundations


https://quickbooks.intuit.com/app/apps/appdetails/billpayqbo/en-us/

@ Guickbooks.

Module 1 Doable Action Steps

If you do not need this feature skip this section. Otherwise follow the steps.

1. Review video links:

How to Manage Your Vendor List: Adding, Editing & Removing (:39)

How to Record Spending: Transactions, Bills & Payments (1:46)

How to manage bills with QuickBooks Online (3:38)

How to Setup a Contractor (2:23)

2. Provide service vendors a W-9 and enter 1099 tracking information.
a. Navigate to the Vendor Center and edit the vendor.
b. Add Business ID -> Select Track payments for 1099.

3. Determine if you will use the bill pay app or manually enter and pay bills.
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Online Foundations Training

SECTION 6
BANK & CREDIT CARD
ACCOUNTS

Goals

Connect Accounts
Banking Center
Transfers
Reconcile Accounts
Action Steps
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Section 6 Goals

Upon completion of Section 6, each participant will be familiar with:

* How to connect bank and credit card accounts.
* How to manage transactions.

* How to transfer funds.

* How to reconcile bank and credit card accounts.

* How to access and view bank reports.
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Connect Accounts

Connecting bank and credit card accounts to QuickBooks Online is a simple
process. It is important you understand how to manage the Bank Center to avoid
posting old and/or duplicate transactions. Although connecting your bank and credit
card accounts is a great way to enter historical transactions, it is recommended that
new users also become comfortable manually entering transactions. Please seek
help from your instructor or accountant to avoid costly cleanup if you believe you

need additional assistance.

There are two ways to connect bank and credit card accounts to your company file.

BANK ACCOUNTS f
Checking
Bank balance -53,621.93
. . n QuickBooks $1,201.00 momen
The First Option:
Savings 1 to review
1. Click dashboard in the left navigation bar. Jonk baanes R s
2. Click Connect accounts. Mastercard
Bank balance $304.96 Updatec
n QuickBooks $157.72 moments ago
Visa
n QuickBooks

Go to registers W

| Link sccount |
e A

The Second Option: Upload from file

Manage connections

1. Click banking in the left navigation bar.

Order checks

2. Click Link account.
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Banking Center

Let’s walk through the manual export and import process for bank and credit card
transactions. Once you login to your online bank account outside of QuickBooks
Online, determine how transactions are exported, the date range available and the
type of export available. Some banks won’t let you go back more than 18 months (or
even 3 months) at a time. There might be several download file types available,
depending on which bank you use. The QuickBooks web connect option is
preferred. Once you successfully download and save the export file from your bank,
the next step is to go to the Banking Center in QuickBooks Online.

1. Click banking -> drop-down arrow to the right of Link account -> Upload
from file.

2. Click browse and select the bank file you downloaded from your computer.

3. Click continue. Follow the connection wizard.

Manually upload your Bring in transactions
.
p - transactions oF automatically
| Link account b
h ~ How it works Link your accounts to save time on entering bank
transactions.
U[ClCﬂEl TrI'C m fll& Open a new tab and sign in to your
1 online bank account. C Q, Find your bank )
Manage connections
2 Export your bank statement in a .CSV, Select from these popular banks or search 10,000+
.OFX,.QBO, .OFX, or TXT format. ocal and international banks.
Order checks :
3 Upload your bank statement. Cr\l CHASE O 4;..&

@ Drag and drop or select
files WELLS
i Capital .

4. Select the account category from the chart of accounts list you want the
transactions to connect with. Be careful!
Which account are these transactions from?

Selectsd File: Inflow Cradit Cerd Transactione_Bank [mport File.cev

Selact s QuickBooks account for the bank fils you want to upload

QuickBocks Account

21000 Chaz=s 1125 b
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Banking Center

Map fields between QBO and the bank account.
5. Select the field options, change the Amount field to Spent and select one of the
column options. Click Continue.

Let's set up your file in QuickBooks

Step 1: Tell us about the format of your data

Ia the first row in your file 8 header?

|Yes v|

How many columns show amounts?

| One celumn v |

What's the date format used in your fila?

| M/ yyyy v |

Step 2: Select the fields that correspond to your file

QuickBooks fields Columns from your file

Column 3: Date v |

Description | Column 4: Description |

Amount | Column &: Spent v |

6. Select all the transactions available to import. Click Continue.
A window will appear to inform you how many transactions are being imported.
Make sure all transactions are selected. Sometimes the system will not accept a
transaction, simply uncheck those with issues and manually enter them later.

7. Do you want to import now? Click Yes -> Done.
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Banking Center

Banking Center

Now that your bank and credit card accounts are connected, you can manage
transactions for each account. Organize your bank and credit card accounts to
avoid posting duplicate transactions. Start with main checking, additional checking,

savings, then credit card accounts.

1. Click dashboard from the left navigation bar -> Bank accounts pencil -> re-

arrange the order of accounts -> Save.

[%p]
£

“:}, Bank accounts s

Bank accounts
Checking 95 to review Checking
A L } Bank balancs

om i e
B-3,0271. %3
Bank balance £-3,621.93 N PR
n O 'c<;|::-|:|:5 21 :51 EE T In QuickBooks £1,201.00
QuickB ,201. CMents 8go
. ) Savings
Savings o review 9
Bank balancs £200.00 Bank balancs 2200.00
= alal = S L . - &
In OuickBooks £200.00 e - In QuickBooks Z800.00
LA = = Py - =
Mastercard 7 1o review Mastercard
Bank balance £304 06 Bank balance 230496
= ol PV, g8
OuickBo 157 72
In QuickBooks $157.72 mMoments 5 In QuickBooks £157.72
Visa Visa
. OuickBo &n
)| In QuickBooks 50

In QuickBooks
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Banking Center

2. Click banking (transactions) in the left navigation bar.
The Banking Center window will appear. All accounts linked to the bank or

transactions manually imported will appear in the Banking Center. Click on the

bank or credit card account you would like to manage.

e Checking v \< Link account
Checking Savings = Mastercard =
-$3,621.93 $200.00 $304.96
BANK BALANCE BANK BALANCE Updated moments ago BANK BALANCE Updsted moments ago
$1,201.00 ; $800.00 1 $157.72 F
IN QUICKBOOKS IN QUICKBOOKS IN QUICKBOOKS

As the bank populates transactions, they reside in the review section of the Bank
Center.

It is up to you to accept these transactions. Once accepted they post to the bank
register and move to the reviewed section. If a duplicate or old transaction appears
for review, simply exclude the transaction. On occasion, you might want to undo an

excluded transaction and move it back to review.

Search or filter transactions to accept or post transactions more efficiently.

! For review (0) Categorized Excluded )

B) Alldates v ‘ i Alltransactions‘ A ‘ Q, Search by dew or check number
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Banking Center

You can access the bank register and other options include printing, exporting to

Excel and changing the columns displayed using the gear icon. We recommend

changing settings to match the screen shots provided.

Take = tour

Go to bank registsr

S

2 &

Columns

3 Check Na.

Payee

Class

Location

Groups

CD Turn on grouping

Transaction dstails

[] Show amounts in 1 column
Editable dats fisld

Copy bank detail to memo

D Show suggested rules
Show bank details
D Enable suggested categorization

Page Size

@ 50
()75
() 100
() 150
() 300

When bank transactions populate in the Bank Center, they look for existing

transactions to find a match. The order in which transactions are posted is important

in order to avoid duplicate transactions and costly cleanup. We recommend the

following industry best practices order:

1. Sync or import payroll when using a payroll service or QuickBooks Payroll.

a > 0B

Clear up undeposited funds.

Apply checks to open bills.

Receive payments against invoices and make deposits.

When posting transactions start with the main checking account and

additional checking, then move on to savings, credit card etc.

6. Open and review each transaction.
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Banking Center

Click on individual transactions to open the window with all available fields. Notice
the different options:

» Categorize —The preferred option. It allows you to control where the
transactions are going and is more forgiving if you need to make changes
later.

» Find match - Looks for a transaction that already exists in the register.
The order of operations is very important. When you complete the
undeposited funds deposit process, the bank feeds will match up the

transactions and all you do is verify and accept them.

(@) Categorize () Find match ) Record as transfer ) Record as credit card payment

Check No.

Vendor/Customer Category * Customer

M Uncategorized Expense M v Billable

* Record as transfer — Recognizes transfers between accounts and
sometimes picks up expenses or ACH payments as transfers. Transfers do
not require a vendor name. Let’s say you are transferring funds from the
checking to the savings account. You can use record as transfer or change
it to Categorize, create a vendor named transfer and select the savings
account as the category from the chart of accounts. Transfers are not as
forgiving if you need to make edits later. Also, it only recognizes balance
sheet accounts.

* Record as credit card payment — Creates a payment from the checking
to the credit card account. This feature is not as forgiving as categorize
and harder to change later. It only recognizes credit card accounts in the

chart of accounts.

143 QuickBooks Online Foundations



@ Guickbooks.

Banking Center

While the transaction is open, verify the date, vendor, category, and any other fields
that require information. When you turn on features such as locations and classes,
they will appear in each transaction. It is your job to assign a location or class as
you accept the transactions. This will prevent having to go back and edit
transactions, a time-consuming process.

* Memo - This is an extremely valuable field that provides bank description
information that tells a story. Often the vendor's name and other important
information can help us to complete the transaction.

* Notice the options to Add attachments, Create a rule, Exclude or Split
transactions.

» Split — Provides the option to split a transaction between account
categories and classes. It can be very helpful when you need to split an

expense or principal and interest for a loan payment.

(@) Categorize | Find match | Record astransfer (_ ) Record as credit card payment

Check No. ‘
Vendor/Customer (@ / Category * @ / Customer ()

v Uncategorized Expense v v [ ] Billable
Location ® Class (@
Tags @ Manage tags
Memao
‘ A1 RENTAL BACKHOE RERTALI ‘
BANK DETAIL AT RENTAL
[Ij] Add attachment @ Create a rule @ Exclude h Sp|it m
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Banking Center

Rules

Rules are a great way to identify where a transaction should be posted. Rules save
time during the review and accept process because they memorize how specific
transactions for specific vendors should be recorded. Keep in mind, QuickBooks will
remember prior posted transactions and populate vendor names and categories
based on the memorization of the rule. Take time to review each transaction before
accepting to avoid costly cleanup errors.

1. Click the rules tab from the banking center -> New rule.

2. Customize your rule by selecting available options, adding conditions,

Transaction type, Payee and Category.

Then Assign v

Create rule

Transaction type Expense v

Rules only apply to unreviewed transactions

. Cat Equi t Rental
What do you want to call this rule? * soen quipment fents

| A1 Rental | Add a split

P.

ayee A1 Rental

Apply this to transactions that are

Customer

| Money out v ‘ in

All bank accounts W/ ‘

Tags

and include the following: | All v ‘ )
+ Assign more

v i v
| Bank text ‘ | Contains | ‘ Al Rental ‘ Automatically confirm transactions this rule applies to

Auto-add ‘\)

+ Add a condition

DY -

Danger! Danger! Turn off auto-add until you are confident using the Banking Center
and rules. Auto-add automatically accepts transactions to the bank register without
your knowledge. We recommend you change description to bank text when setting
conditions. This will help the system recognize transactions to automatically assign

the vendor/customer and account category.
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Banking Center

Chris was learning how to review and categorize transactions in the Banking Center. She
started to panic as she noticed some of the transactions were automatically posting with

incorrect information.

Oh no! An auto-add rule was accidentally created, and transactions are being posted to the

wrong account category. How can she fix this issue?

1. Go to the Banking Center -> Rules -> Delete the rule.
2. Go to the Banking Center -> categorized tab -> locate and undo the transactions.

This will move them back to the review tab. Whew! That was a close one.

What if a duplicate transaction populates or an old transaction re-appears because she
deleted the transaction from the bank register?
1. Go to the Banking Center -> review tab -> exclude unwanted transactions.

This will move the transactions to the excluded tab where you can undo and bring them

back to review if you need them.

Banking

Banking App transactions Rules Tags Receipts

Rules Learn more about bank rules. m

\:| PRIORITY 3 a  RULENAME | APPLIEDTO CONDITIONS SETTINGS AUTO-/ STATU ACTION!
‘:| 1 Al Rental C Bank text contains "A1 Rental” = Set Category to "Equipment .. Active EditId
Copy
i Disable

Delete
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Banking Center

Receipts

Receipt capture in QuickBooks Online allows users to directly upload receipts to
the QuickBooks Online Banking Center where QuickBooks will read the receipt and
either match it to an existing transaction or allow users to add a new transaction.

1. Click the Receipts tab.
2. Options include:
« Drag and drop receipts directly into QuickBooks Online or
select browse to upload them. Ensure that each image or file contains
only a single receipt.
+ Upload from Google Drive by logging into your Google account.
* Forward from email will require you to setup a custom email address

with Intuit.

Receipts Give feedback

....................................................

& & £

Upload from computer i Upload from Google Drive Forward from email
Select files or drag and drop { Access your Google account Set up receipt forwarding

____________________________________________________

Create transactions from uploaded receipts (pdfs).
You can turn receipts into bills or expenses. This step should be completed prior to
managing the Banking Center.

TRANSACTION DATE DESCRIPTION / VENDOR PAYMENT ACCOUNT TOTAL AMOUNT / TAX CATEGORY OR MATCH ACTION
0-00f0

Add

a new receipt to get started
ve'll pull out the info so you can revies

1fo so you can review it and add it to your books
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Transfers

Transfers

In some cases, a payment to a vendor or payee populates as a transfer type
transaction instead of an expense. In this case, we recommend you change it to a

categorized transaction, as explained in the Banking Center section.

1. Click +New and select Transfer to move money from one bank account to

another.
(' Transfer

Transfer Funds From Balance

Checking v $‘| ;201 .OO
Transfer Funds To Balance

v $800.00
Transfer Amount Date

300.00 04/25/2022
Mamo
@JAI‘tachments Maximum size: 20MB

Note: Transfers do not require a vendor name and need to be deleted if you need to

adjust or correct a mistake.
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Reconcile Accounts

Reconciling your bank and credit card accounts is an important task to ensure all
transactions are accounted for, input errors are corrected, and all outstanding
transactions are verified. Completing the bank reconciliation process for all financial
accounts is key to accurate data and financial statements.

1. Click the gear icon -> Reconcile -> get started -> Let’s get reconciled.

2. Select the Account you wish to reconcile from the drop-down list.

3. Refer to the bank statement to verify the Beginning balance, enter the Ending
balance, and enter the Ending Date.

4. Click Start reconciling.

Accounting

Chart of accounts Reconcile
Chart of accounts > Bank register > Reconcile
Reconcile

Which account do you want to reconcile?
Account

Checking

Add the following information

Beginning balance  Ending balance * Ending date *

5,000.00 294514 12/31/2022

Start reconciling

Note: Always reconcile accounts using this process. Never clear transactions
directly from the bank register as this can cause problems.
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Reconcile Accounts

Now you are ready to reconcile the account.
5. Select Deposits and check off all deposit and credit transactions that appear on

the bank statement. Verify outstanding transactions and make corrections as
needed.

Chart of accounts > Bank register > Reconcile

Reconcile Checking

Staternent ending date: December 31, 2022

$2,945.14

STATEMENT ENDING BALANCE

( Edit info )(Saveforlater |v)

$5,486.40

CLEARED BALANCE
-$2,541.26
DIFFERENGE
$5,000.00 $0.00 + $486.40
BEGINNING BALANCE - 0 PAYMENTS 3 DEPOSITS
Show me around
Statement ending date  Clear filter / View all ( Payments Deposits | All )
DATE CLEARED DATE  TYPE REF NO. ACCOUNT PAYEE MEMO PAYMENT (USD) DEPOSIT(USD)\
09/16/2022 Receive Pay... 1053 Accounts Receiv.. Bill's WindsurfS.. 175.00 (]
11/16/2022 Receive Pay... 5664 Accounts Receiv.. Freeman Sportin.. 86.40 o
11/16/2022 Sales Receipt 1008 Design income Kate Whelan 225.00 (]

6. Select Payments and check off all checks and ACH transactions that appear on
the bank statement. Verify outstanding transactions; research and make

corrections as needed.

Chart of accounts > Bank register > Reconcile

Reconcile Checking

Statement ending date: December 31, 2022

$2,945.14

STATEMENT ENDING BALANCE

$4,881.85

( Edit info )(Savefcrlater |v)

CLEARED BALANCE
-$1,936.71
DIFFERENCE
$5,000.00 $604.55 T+ $486.40
BEGINNING BALANCE 3 PAYMENTS 3 DEPOSITS
J Show me arount
Statement ending date  Clear filter / View all ( Payments Deposits All
DATE CLEARED DATE TYPE ACCOUNT PAYEE MEMO PAYMENT (USD) DEPOSIT (USD)
09/08/2022 Bill Payment Accounts Payabl.. Robertson & Ass... 300.00 °
09/30/2022 Expense Legal & Professi... Robertson & Ass... 250.00 o
10/22/2022 Check Automobile:Fuel Chin's Gas and Oil 54.55 °
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Reconcile Accounts

7. Click Edit Info to change the ending balance or statement date.
Verify that the following match the bank statement:

1. Beginning Balance
2. Statement Ending Balance
3. Payments Total
4. Deposit Total mb
Finish now
Save forlater
The Difference should be $0.00 when you are done. Close without saving

8. Click the drop-down arrow to choose one of the following options:
* Finish now to complete the bank reconciliation process.
« Finish later to save your work and resume later.
» Close without saving to start over—your work will not be saved.

Chart of accounts > Bankregister > Reconcile

Reconcile Checking Editinfo m
Statement ending date: December 31, 2022

$2,101.00 ) $2,101.00
STATEMENT ENDING BALANCE CLEARED BALANCE ° $O 00
DIFFERENCE
$5,000.00 $6,170.35  ,  $3,271.35
BEGINNING BALANCE - 31 PAYMENTS 11 DEPOSITS

Now that we have completed a successful bank reconciliation in QuickBooks, you
can click Done or View Report (a reconciliation report will open providing summary
and detail information).

You reconciled this account
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Reconcile Accounts

Once the bank and credit card accounts are reconciled, reports and historical
information are available from the reconcile window. If you are no longer in the
reconcile window, click gear -> Reconcile. Click Summary to access a list of recent

reconciliation summaries.

Chart of accounts > Bankregister > History by account > Report

Reconciliation report Reconcile | History by account
Account Statement ending date

Checking 12/31/2022 v Hide additional information

Craig's Design and Landscaping Services
Checking, Period Ending 12/31/2022

RECONCILIATION REPORT
Reconciled on: 01/16/2023
Reconciled by: Craig Carlson

Any changes made to transactions after this date aren't included in this report.

Summary usb
Statement beginning balance 5,000.00
Checks and payments cleared (31) -6,170.35
Deposits and other credits cleared (11) 3,271.35
Statement ending balance 2,101.00

Click History by account to access all reconciliation summaries by account.

Chart of accounts > Bank register > History by account
History by account Summary | Reconcile | Show me around
Account Report period
Checking Since 365 Days Ago v
STATEMENT ... RECONCILED ... ENDINGB... CHANGES AUTO ADJ... STATEMENTS ACTION
2022
12/31/2022 01/16/2023 2,101.00 0.00 Attach View report Vv

Click Show me around for a step-by-step tour.
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Reconcile Accounts

Once the bank and credit card accounts are reconciled, reports and historical
information are available from the reconcile window.

1. If you are no longer in the reconcile window, click gear -> reconcile.

2. Click summary to access a list of recent reconciliation summaries. Double-click

the summary you wish to review.

Chart of accounts > Bank register > Reconciliation summary

ReconCiIiation summa ry Reconcile | History by account

Craig's Design and Landscaping Services

RECONCILIATION SUMMARY

ACCOUNT TYPE STATEMENT ENDING DATE RECONCILED ON

Checking Bank 12/31/2022 01/16/2023

3. Click the Hide additional information to hide transactions after Period end
date.

Chart of accounts > Bank register > History by account > Report

Reconciliation report Reconcile | History by account
Account Statement ending date

Checking 12/31/2022 v Hide additional information @

Craig's Design and Landscaping Services
Checking, Period Ending 12/31/2022
RECONCILIATION REPORT
Reconciled on: 01/16/2023
Reconciled by: Craig Carlson

Any changes made to transactions after this date aren'tincluded in this report.

Summary uso
Statement beginning balance. 5,000.00
Checks and payments cleared (31). -6,170.35
Deposits and other credits cleared (11) 3,271.35
Statement ending balance 2,101.00
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Section 6 Action Steps

All business owners should complete this section and apply the knowledge to their
own company file. Remember! You can always refer to various sections of training if

you need additional reminders of how features works.

1. Review video links:
How to Connect your Bank Account & Credit Cards (3:06)

How to Categorize Transactions from your Bank and Credit Card (4:01)

How to Reconcile an Account: Statements & Records, & More (2:39)

2. Connect your bank and credit card accounts.

3. Accept transactions for connected accounts. Remember to complete all
fields required and always fill in customer/vendor and category fields.

4. Create rules as needed.

5. Reconcile your bank accounts.

6. Reconcile your credit card accounts.

Best Practices
» Keep a separate bank and credit card account for your business. Avoid
using them for personal transactions. This will reduce the number of
transactions, vendor’s you will need to create and will keep cash in the

company.

» Follow the order of operations when posting accounts and transactions.
» Create rules to help with accuracy and efficiencies.

» Reconcile bank and credit card accounts each month.

» Monitor bank balances from your computer or mobile app.
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